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ご使用の前に 

 

お客様各位 

 

拝啓 

 

貴社ますますご盛栄のこととお喜び申し上げます。平素は格別のお引き立てを頂き、厚く御礼申し上げま

す。 

さて、この度は、MODEL400 シリーズをお買い上げ頂き誠にありがとうございます。 

本書は、MODEL400 シリーズを正しくお使い頂く為の操作方法を説明しておりますので、ご使用になる前に

必ずお読み下さい。 

 

MODEL400 シリーズを本書とともに末永くご愛用頂きますよう、心からお願い申し上げます。 

 

敬具 

 

ユーザー登録（保証登録）のお願い 

ミナト・アドバンスト・テクノロジーズでは、お買い上げ後のサポートサービスを行わせて頂いております。 

弊社ホームページの保証登録フォーム（保証登録はこちら）より登録をお願いします。 

 

登録する際、事前に下記 3 項目を確認しておく事をお勧めします。 

製品名 

本体のシリアル番号 (本体背面に記載) 

本体 Ver. ( CD-ROM に記載 ) 

 

故障内容によっては、無償で保証をお受け出来ない場合がございます。 

詳しくは、「保証規定」をお読み下さい。 

 

ミナト・アドバンスト・テクノロジーズ株式会社 ホームページ 

 

http://www.minatoat.co.jp 

 

 

 

http://www.minatoat.co.jp/
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MODEL400シリーズに接続する PC環境 

 

MODEL400シリーズのOS環境 

 Windows XP （SP3 以上） 

 Windows Vista 

 Windows 7 ( 32bit版, 64bit版 対応) 

 Windows 8，8.1 ( 32bit版, 64bit版 対応) 

 Windows 10 ( 64bit版 対応) 

 

推奨するPC環境 
 ＣＰＵ     Pentium４ １ＧＨｚ以上 

 ＲＡＭ容量     ５１２ＭＢ以上 

 ハードディスク   1GB 以上 空き容量 

 インターフェイス  ＵＳＢ２．０以上 

 USBポート    1 個 以上 

 CD ドライブ   ＣＤ－ＲＯＭリーダー 

 

 

 

ハードディスクの空き容量はお客様が使用するターゲットデバイスの容量に依存します。 

大容量デバイスをスムーズに書き込むためには、空き容量が十分なハードディスクを使用して下さい。 

 

初めてPCをMODEL400シリーズギャングプログラマに接続する際には、下記の資料をお読みになって

から内容事項に従って接続をお願いします。 

 

[ プログラマ本体と初めて接続するPCの注意事項 ] 
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MODEL400 シリーズ 梱包リスト 

ここでは、MODEL400 シリーズをお買い上げ時に同梱されているものを記載しています。開封時に内容及

び数量の確認をお願いします。 

万一、異常がありましたら、販売店または、弊社までご連絡下さい。 

 

[ 梱包リスト ] 

・MODEL400 シリーズ 本体  (MODEL404，404e+ MODEL408，408e+ MODEL416，416e+) 

・ソケットユニット ( SU400-48DP/3ｖ )  ※各プログラマのユニット数 

   ( MODEL404，404e+ / 1 個 , MODEL408，408e+ / 2 個 , MODEL416，416e+ / 4 個 ) 

・電源ケーブル 

・USB ケーブル 

・CD   （ MＯＤＥＬ400 シリーズ用コントロールソフトインストーラ (アプリケーションソフト),  USB ドライバ

インストーラ,取扱説明書 [ PROGRAMMER マニュアル ] ） 

 

 

MODEL404，404e+ 

MODEL408，408e+ 

MODEL416，416e+ 
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保証規定 

ここでは、MＯＤＥＬ400 シリーズの製品保証について記述しています。 

弊社から出荷後、1 年間の無償修理期間（ユーザー登録完了済みのものに限ります）を設けていますが、

保証の制限により、無償修理保証に該当しない場合がありますので、ご使用の前に、下記の文章を必ずお

読み下さい。 

 

無償保証期間 
無償保証期間は、弊社より出荷後、1 年間とさせて頂きます。 

 

無償保証に該当するもの 
1. 弊社より出荷後、1 年以内の製品。 

2. ユーザー登録完了の製品。 

3. 正常なご使用状態のもとで故障した場合。 

4. MＯＤＥＬ400 シリーズ本体のハードウェア部分。 

5. 本保証規定は日本国内で使用する場合。 

(This warranty is valid only in Japan) 

 

 

有償修理に該当するもの 
保証期間内であっても、次の項目に該当する場合は、有償修理となります。 

 

1. ユーザー登録をしていない製品。 

2. ユーザー登録に未記入の箇所がある場合。 

3. お客様の誤ったお取り扱いによる事故。 

4. 天災による事故。 

 

 

保証対象外 
次の項目に該当する場合、弊社では一切の責任及び保証は出来ませんので、ご了承ください。 

1. デバイス及びデータの保証。 

2. 故障時に生じた直接的、間接的な費用。 

3. 国内以外で使用される場合。 

4. 弊社純正品以外の機器を使用した際に生じた不具合及び、トラブル（他社の変換アダプタ/ソフトウェアの

使用）。 

5. 弊社以外で修理や改造等を行ったもの。 

6. 取扱説明書に反する使用方法によって生じた故障。 

7. MＯＤＥＬ400 シリーズのバージョンアップ.。 

MＯＤＥＬ400 シリーズのバージョンアップは別途、費用が掛かります。詳しくは、MＯＤＥＬ400 シリーズの保

守「MODEL400 シリーズのバージョンアップ（デバイス/ソフトウェアサポート）」をお読みください。 
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特記事項 
1. 保証登録を、弊社宛に返送して頂きますと、保証登録完了となります。 

2. 修理品を弊社宛へ発送して頂く際、発送に掛かる輸送費用はお客様負担とさせて頂きますのでご了承くだ

さい。 

3. 本製品が梱包されてくる梱包箱（製品箱）は修理等で輸送する時に利用出来ますので、大切に保管してくだ

さい。本製品を輸送する場合は、弊社指定の梱包箱（製品箱）と梱包材を使用し、しっかりと梱包してくださ

い。梱包が不十分ですと製品が破損する場合があります。輸送時に発生した破損部分の費用は、この場

合、お客様の負担とさせて頂きますので、ご了承願います。 

4. 修理完了品をお客様へ返送させて頂く場合、輸送費は弊社にて負担させて頂きます。 

5. 本書は予告なく変更する場合がございます。ご了承ください。 

6. ご不明な点がございましたら弊社までご連絡ください。 
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MODEL400 シリーズの保守 

MODEL400 シリーズ（以下 MODEL400 シリーズ）を最良の状態でご使用頂く為の記述事項です。 

 

製品保証 
MODEL400 シリーズは、弊社から出荷後、1 年間の無償修理が受けられます（ユーザー登録完了済みのも

のに限ります）。詳しくは、「保証規定」をお読み下さい。 

 

 

MODEL400 シリーズ バージョンアップ（デバイス/ソフトウェアサ

ポート） 
新規デバイス対応、デバイス仕様変更によるソフトウェア等のバージョンアップをサポートさせて頂きます。

MODEL400 シリーズが無償期間内であっても、バージョンアップサポートは、保証対象外の為、これらの作

業は、別途、費用が掛かりますので、ご了承下さい。 

※但し、弊社によるソフトのバグ等は無償にて改善させて頂きます。 

 

定期校正 
MODEL400 シリーズは、生産機器であり、安心してご利用頂く為にも、日頃の点検と年 1 回の定期校正を

お勧めします。 

 

 

修理、定期校正、バージョンアップについて 
有償、無償に関わらず、出張修理は行っておりません。 

また、代替え機等はご用意しておりませんのでご了承下さい。 

修理、定期校正、バージョンアップ等の製品発送に掛かる費用はお客様負担とさせて頂きますのでご了承

下さい。 

完成品の返送に掛かる費用は弊社にて負担させて頂きます。 
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安全にお使い頂く為に 

安全上の注意 
ＰＲＯＧＲＡＭＭＥＲマニュアルには、ギャングプログラマ MODEL400 シリーズを安全に正しくお使い頂く為に

安全表示が記述されています。 

MODEL400 シリーズを安全に正しくお使い頂いて、お使いになる方や他の人々への危害や財産への損害

を未然に防止する為に、次のように絵表示で説明しています。 

これら絵表示と意味を十分理解した上で本書をお読みください。また本書は保管して、必要に応じて参照し

て下さい。 

 

 

 

 

 

 

絵表示の説明 

 

 
警告 

 

この表示の注意事項を守らないと、使用者が死亡または重傷を

負う可能性が想定される内容を示しています。 

注意 

 

この表示の注意事項を守らないと、使用者の怪我または物的損

害の発生が考えられる内容を示しています。 
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警告
 

 

本製品を使用する際は、必ず弊社ミナトアドバンストテクノロジーズが提示する警

告、注意指示に従って下さい。 

 

 

 

 

 

本製品の分解や改造はしないで下さい。火災や感電のおそれがあります。 

 

 

 

 

 

 

煙が出たり、変な臭いや音がしたら、すぐに AC コンセントからプラグを抜いて下さ

い。 

そのまま使用を続けると、ショートにより火災や感電する恐れがあります。 

 

 

 

本製品を落としたり、強い衝撃を与えたりした場合は、すぐにＡＣコンセントから電

源プラグを抜いて下さい。 

そのまま使用を続けると、ショートにより火災や感電する恐れがあります。 

弊社修理窓口にご相談ください。 

 

 

液体や異物などが内部に入ったら、すぐにＡＣコンセントから電源プラグを抜いて

下さい。 

そのまま使用を続けると、ショートにより火災や感電する恐れがあります。 

弊社修理窓口にご相談ください。 

 

 

 

 

 

 

 

電源プラグを抜く 

電源プラグを抜く 

電源プラグを抜く 

分解禁止 

強制 
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注意
 

 

本製品ご使用の際は、本取扱説明書をご理解された MODEL400 シリーズのオペ

レータの方が操作に当たって下さい。 

誤ったオペレーションは、本製品またはデバイスを破損させる可能性があります。 

 

 

 

静電気による破損を防ぐために、本製品にふれる前に身近な広い面積の金属に

素手で触れて、身体の静電気を取り除くようにして下さい。 

静電気により、本製品またはデバイスを破損する恐れがあります。 

 

 

 

本体表面、デバイスソケットおよびエアーフィルタの清掃をして下さい。 

ほこりがたまったままのご使用は、火災や故障の原因になることがあります。定期

的な清掃をして下さい。 

 

 

 

コンタクトチェック及び ID チェック時の LED（赤色）表示デバイスソケットにデバイス

を挿入したままの状態で書き込みはしないで下さい。 

発熱し、本製品またはデバイスを破損する恐れがあります。 

 

 

 

PASS/ FAIL の判定は必ずチェックサムを確認して下さい。 

書き込み不良のデバイスが製品に混入する恐れがあります。 

 

 

 

 

 

 

 

 

強制 

強制 

強制 

強制 

強制 
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付属品についての注意事項 

本製品に付属している電源ケーブルは、日本国内で使用される為に、電気安全

法に従い、適合検査を受けたものです。 

国外で使用する場合は、使用される国の安全規格を満足する電源コードに交換し

てご使用下さい 

 

 

 
強制 
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プログラマ本体の概要 

製品概略 

MODEL400シリーズは、ＵＳＢポートを持った、WindowsベースのPCで利用できるギャングプログラマです。 

大容量化の進むPROMデバイス群に柔軟に対応できます。標準32Gbyte（25Gbit）又は標準64Gbyte

（512Gbit：e+）の大容量バッファメモリ(micro SD memory)を搭載し、小ロット生産や回路設計技術者向けに

設計しました。 

高信頼性かつ高速動作する、今までに例を見ない抜群のパフォーマンスを得ることができます。 

 

特徴 

 動作環境の大幅な向上 

 動作スピードの向上 

 256Gbit のバッファメモリ(SD memory)を標準搭載(M404,M408,M416) 

 512Gbit のバッファメモリ(micro SD memory)を標準搭載(M404e+,M408e+,M416e+) 

 豊富な対応デバイス 

 既存の変換アダプタも使用可能 

 

仕様 

項目 MODEL404、 

404e+ 

MODEL408、 

408e+ 

MODEL416、 

416e+ 

備考 

同時書き込み数 4 8 16  

バッファメモリ 256Gbit(404) 

512Gbit(404e+) 

256Gbit(408) 

512Gbit(408e+) 

256Gbit(416) 

512Gbit(416e+) 

各 512Gbit(max.) 

各 e+:1024Gbit(max.) 

外部インターフェイス USB USB USB Rev.2.0 準拠 

動作温度 5－35 [℃] 5－35 [℃] 5－35 [℃]  

動作湿度    ―    ―    ―  

電源 AC100-240 [V] 

50-60 [Hz] 

AC100-240 [V] 

50-60 [Hz] 

AC100-240 [V] 

50-60 [Hz] 

 

消費電力 60 [VA] (max.) 100 [VA] (max.) 200 [VA] (max.)  

ヒューズ 3 [A] 3 [A] 3 [A]  

寸法 230(W)x260(D)x110(H) 

[mm] 

380(W)x260(D)x110(H) 

[mm] 

380(W)x390(D)x120(H) 

[mm] 

 

重量 2.4 [kg] 5.2 [kg] 9.0 [kg]  
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MODEL400 シリーズの各部の名称と機能 

MODEL400 シリーズを正しくご使用頂く為に、各部の名称と機能概要について説明します。詳しい説明は

個々の操作説明にて述べます。 

MODEL400 シリーズを使用するには、専用コントロールソフトとソケットユニットが必要になります。専用コン

トロールソフト以外のソフトでは起動できませんのでご注意下さい。専用コントロールソフトの詳しい説明

は、本書内 MODEL400 シリーズ用コントロールソフト操作マニュアルをご覧下さい。ソケットユニットの詳し

い説明は、ソケットユニットについてをご覧下さい。 

 

例 ）  MODEL404，404e+  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

START

STATUS

 

ソケットユニット実装位置 

スタートキー 

ステータスランプ 

リアパネル 
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ソケットユニット実装エリア 

 

例 ）  MODEL404、404e+ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ソケットユニットナンバー 
各ソケットに番号が与えられています。 

取扱説明書で扱うソケットユニットのナンバーの表現は“#“を加えた表現をします。 

（例） 

2 番のソケットユニットは“#2“とします。 

 

ソケットユニット差込口 
ソケットユニットを実装する為の差込口です。 

 

 

ソケットユニット差込口 
ソケットユニットナンバー（#1～#4） 

START

STATUS

1 2 3 4

 

ソケットユニット実装 
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ソケットユニット LED ランプ（PASS/FAIL インジケータ） 
動作結果を点灯色で表示します。 

PASS 時  緑色 

FAIL 時  赤色 

 

START

STATUS

1 2 3 4
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リアパネル 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

電源コネクタ 

AC 電源用入力コネクタです。FUSE(3A)を内蔵しています。 

 

 

電源スイッチ 

電源スイッチです。 

 

 

USB コネクタ 

USB 用コネクタです。 

 

 

通風孔 

MODEL400 シリーズ本体内部を冷却する為の外気吸い込み部分です。塞がないように注意してください。

エアフィルターの塵埃が目立ってきたら、掃除機等で塵埃を吸い取ってください。 

 

 

シリアルナンバー 

本体個々に、製造番号を刻印したシールが貼ってあります。お問い合わせの時に確認していただく場合が

あります。 

 

 

レビジョンナンバー 

ハードウェアのレビジョン管理シールです。お問い合わせの時に確認して頂く場合があります。 

 

 

MODEL 404

REV.No

 

シリアルナンバー レビジョンナンバー 

USB コネクタ 

電源コネクタ 電源スイッチ 

通風孔 
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別売品 

MODEL400 シリーズ購入時に標準のソケットユニットが付属しています。 

付属のソケットユニット以外に、オプションとして以下のソケットユニット及び変換アダプタを用意しておりま

す。 

お客様が使用するデバイスに合わせたソケットユニット及び変換アダプタをご使用下さい。 

 

ソケットユニット

各種変換アダプタ

TEXTOOL

248-1282-
00

PAT.No.3763489TEXTOOL

248-1282-
00

PAT.No.3763489

SU400-48DP/5v

A1

Hxx-xxxx

※  各種自動プログラミングシステム（ハンドラ）もご用意しております。
     詳細は弊社営業担当までお問い合わせ願います。

SU400-48DP/5v

(開発中)

A
1

CBG176-
101A

11
×1
4

A
1

CBG176-
101A

11
×1
4

SU400-xxxx

A
1

CBG176-
101A

11
×1
4

A
1

CBG176-
101A

11
×1
4

CBG176-101A

11×14
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ソケットユニットについて 

ソケットユニットには様々なタイプがあります。ここでは代表的なソケットユニットの種類と実装方向（差込方

向）を説明します。 

尚、ここで説明されている以外のソケットユニットで、実装方向がご不明な場合は弊社までお問い合わせ下

さい。 

 

※ 本体には、必ずソケットユニットを装着して下さい。 

本体の電源投入後に、装着しても動作しません。 

必ず本体の電源投入前に、ソケットユニットを装着するようお願いします。 

弊社専用のコントロールソフトで本体を動作させた時に、弊社製のソケットユニットが装着していないと

動作しませんのでご注意下さい。 

 

 

ソケットユニットの種類 

他に様々なタイプがありますが、その中の 3 タイプを取り上げて説明いたします。 

 

 

① SU400-48DP/3v 

3v 専用のソケットユニットです。 

各種変換アダプタにも対応しています。 

 

 

② SU400-48DP/5v （ 開発中 ※別売品 ） 

5ｖ専用のソケットユニットです。 

各種変換アダプタにも対応しています。 

 

 

③ SU400-xxxx 

上記のソケットユニットでは対応できないパッケージ/デバイスを対応したソケットユニットです。 

 

 

 

各種変換アダプタ 

M1940,M1950 で使用可能なアダプタをソフトウェア対応で MODEL400 シリーズでも使用可能になった変換

アダプタです。但し、MODEL400 シリーズで使用するには上記のソケットユニットが必要です。 

※詳しくは「変換アダプタについて」をご覧ください。 
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ソケットユニットの装着方向 

 

MODEL400 シリーズへ装着する方向（差込方向）を説明します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ロックレバー（開閉レバー） 

デバイスを挿入する時はレバーを起こします（開けた状態）。 

固定する時は、レバーを倒します（閉じた状態）。 

これでデバイスをセットした状態（プログラマ動作が可能な状態）になります。 

 

 

デバイスソケット 

DIP タイプ以外の TSOP,BGA タイプのソケットユニットは、デバイスソケットを押しての開閉となります。 

 

 

基板の切欠き部分 

ソケットユニット差込口に実装する時の目印となります。 

 

  

TEXTOOL

248-1282-
00

PAT.No.3763489TEXTOOL

248-1282-
00

PAT.No.3763489

A
1

CBG176-
101A

11
×1
4

A
1

CBG176-
101A

11
×1
4

ロックレバー
（開閉レバー）

基板の切欠き部分デバイスソケット

SU400-48DP/3V SU400-xxxx

TEXTOOL

248-1282-
00

PAT.No.3763489TEXTOOL

248-1282-
00

PAT.No.3763489

A
1

CBG176-
101A

11
×1
4

A
1

CBG176-
101A

11
×1
4

 

PASS/FAIL 表示 LED 
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ソケットユニット実装方向 

 

 

 
 

 

 

 

 

 

 

 

 

ロックレバーのあるソケットユニットは、

ロックレバーを手前にして装着します。 

基板の切欠き部分のあるソケットユニットは、

切欠き部分を手前にして装着します。 

ロ ッ ク レ バ ー 、 基 板 の 切 欠 き 部 分 が 無 い ソ ケ ッ ト ユ ニ ッ ト は 、

PASS/FAIL 表示 LED を手前にして装着します。 
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変換アダプタについて 

ここでは MODEL400 シリーズで使用可能な変換アダプタの説明を記載しています。 

 

本書で述べる変換アダプタとは・・・ 
1. 本書では、MODEL400 シリーズに対応している変換アダプタだけを指します。 

2. MODEL400 シリーズで未対応の変換アダプタも、ソフトウェアのバージョンアップによって、 

対応可能です。 （一部、対応出来ないものもあります） 

3. 複数のアダプタが存在する為、本書では「各種変換アダプタ」と記載しています。 

 

ご注意ください！ 
変換アダプタをご使用頂く場合は、別途、ソケットユニットの SU400-48DP/3v が必要となります。 

SU400-48DP/3v (ソケットユニット) が変換アダプタとプログラマ本体の間に必要です。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

A1

CBG176-101A

11×14

各種変換アダプタ
（Hxx-xxxx)

変換アダプタを
使用する場合は

SU400-48DP/xxが
必要

ソケットユニット

各種変換アダプタ
対応デバイス

SU400-48DP/3v

DIPのデバイス

デバイス

SU400-48DP/5v  (開発中)

START

STATUS

1 2 3 4

TEXTOOL

248-1282-
00

PAT.No.3763489TEXTOOL

248-1282-
00

PAT.No.3763489TEXTOOL

248-1282-
00

PAT.No.3763489TEXTOOL

248-1282-
00

PAT.No.3763489

TEXTOOL

248-1282-
00

PAT.No.3763489TEXTOOL

248-1282-
00

PAT.No.3763489
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インストールについて 
 
             ソフトウェア及びハードウェアのセットアップを行います。  

    

※ MODEL400 シリーズをはじめて PC に接続させる時の注意事項   

（ 重要 ） 

 

 



インストールをする 
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インストールをする 

ＭODEL400シリーズ用コントロールソフト( Universal Control Program )、ＵＳＢドライバ、取扱説明書を記録

したＣＤ－ＲＯＭが入っています。 

ＵＳＢで接続したプログラマをコントロールソフトで動作させるためには、ＵＳＢドライバ並びにMODEL400シ

リーズ用コントロールソフトを正しくインストールする必要があります。  

 

※ プログラマとPCを接続する前にソフトウェアのインストールをして下さい。 

 

ソフトウェアをセットアップする 

 

ソフトウェアをセットアップする PC のＣＤドライブにＭODEL400 シリーズプログラマに付属しているＣＤを入

れて下さい。以下のインストーラが入っていますのでインストールして下さい。 

 

OS Windows XP(SP3) Windows Vista/7/8 (32bit) Windows Vista/7/8/10(64bit) 

 M400installer_vxxxx.exe ( MODEL400 シリーズ用 コントロールソフト ) 

USB 

ド ラ イ

バ 

フォルダ名“XP” 

M400_USB_driver.exe 

フォルダ名“Vista以降 OS 対応” 

M400_USB_driver32_v200.exe 

フォルダ名“Vista 以降 OS 対応” 

M400_USB_driver64_v200.exe 
Window10 では USB ドライバを 

インストールする必要はありません。 

 

各インストーラをダブルクリックすると自動的にインストールプログラムが起動します。 

ＭODEL400 シリーズ プログラマ本体を動作させる前に、必要な全てのインストールを行って下さい。 

 

下記にインストール方法を示します。指示に従ってインストールをお願いします。 

 

[ インストール方法について ] 

 

MODEL400 シリーズ用コントロールソフトのインストール 

    M400installer_vxxxx.exe をダブルクリックして下さい。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

[次へ(N) >] を押して下さい。 
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   デスクトップ上にショートカットを作成する場合、  を入れて下さい。 

自動インストールされます。 

 

 

         

 

 

 

 

 

 

 

 

 

 

 

 

 

   上記の表示が出ればインストール完了です。  

      完了ボタンを押して下さい。 

 

 

※ 同様に USB ドライバもインストールして下さい。 
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ハードウェアをセットアップする 

ＭODEL400シリーズ用コントロールソフト( Universal Control Program )を起動する前にＭODEL400シリーズ 

プログラマと PC をＵＳＢケーブルで接続します。 

 

Ｗｉｎｄｏｗｓシステムは新しいハードウェアを検出しますので、ＵＳＢドライバのインストール方法を指定しま

す。 

プログラマが正常に検出され、ＭODEL400シリーズプログラマのインストールが開始されます。 

（PCのＣＤドライブに付属のインストールＣＤ－ＲＯＭをセットしておいてください） 

 

 

Ｓｅｔｕｐ １ 電源ケーブルをコンセントに接続します。 

（延長ケーブルは使用しないでください） 

 

Ｓｅｔｕｐ ２ ＵＳＢケーブルをプログラマに接続します。 

 

 

Ｓｅｔｕｐ ３ ＵＳＢケーブルをPCに接続します。 

（推奨はＵＳＢ２．０ハイスピード） 

 

 

Ｓｅｔｕｐ ４ ＭODEL400シリーズプログラマの電源を入れてください。 

ブザー及びSTATUSランプが正常に立ち上がることを確認して下さい。 

 

 

Ｓｅｔｕｐ ５ Ｗｉｎｏｗｓシステムは“新しいハードウェアの検出Ｗｉｚａｒｄ”をスタートします。 

 

 

  

 

 

 

 

 

 

 

 

 

                                           選択して下さい。 

 

 

 

  ソフトウェアを自動的にインストール（推奨）を選びます。 

 

 

      ソフトウェアのインストールが始まります。 
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ドライバの認証画面になります。 

 

 

 

    

 

 

 

 

 

 

 

 

                                          続行を選択して下さい。 
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       ドライバーソフトウェアのインストール完了画面になります。 

 

 

 

 

 

 

 

       

 

 

 

                

 

 

     完了をクリックして作業は終了です。  

 

※ 注意 ※ 
尚、MODEL400シリーズにおいては搭載されるユニット(COMポート)分の新しいハードウェアが

検出され、M416、416e+プログラマは計４回、M408、408e+プログラマは計2回ハードウェアのイ

ンストールが繰り返されます。 
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プログラマ本体と初めて接続するＰＣの注意事項 

(( はじめて接続する PC 上でのお願い )) 

 

Windows XP（SP3）をお使いの場合は、以下の作業を行ってください。行わないと、MODEL400 シリ

ーズがＰＣに認識されません。（Windows Vista/7/8/10 では、必要ありません） 

 

 

① PC上の以下の場所にある、ファイルをコピーして下さい 

C;\Windows\ServicePackFiles\i386 又は D;\Windows\ServicePackFiles\i386 

    にアクセスし、その中に usbser.sys  ファイルがあります。 

    

ファイルを コピー して下さい。 

 

② コピー したものを以下のところに、貼り付けて下さい。 

C;\Windows\ｓystem32\drivers 又は D;\Windows\ｓystem32\drivers 

 

③ 貼り付けたら、MODEL400シリーズ本体とPCを接続してプログラマ本体の電源を立ち上げて下さい。ハ

ードウェアの再セットアップが行われます。セットアップ完了後にプログラマが認識されたかチェックしま

す。 

 

④ [ スタート ] → [ 設定 ] →  [ コントロールパネル ] → [ システム ]  

 

 

 

    → [ ハードウェア ] → [ デバイスマネージャ ] 

 

 

  デバイスマネージャでポート確認します。 

   

  プログラマ本体を認識していれば、 

  右図のような表示が現れます。 

 

  表示が出ていればプログラマを認識しています。 

 

MODEL400アプリケーションのアイコン  

 

をクリックしてアプリケーションを立ち上げて下さい。 

 

 

 

 

 

 

MODEL404，404e+

の場合; 

M404 Programmer 

 (COMxx) 
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MODEL400 シリーズ用コントロールソフト 

（Universal Control Program） 

操作マニュアル 
 

 

ここでは MODEL400 シリーズ用コントロールソフトの基本的な操作方法を説明します。MODEL400 シリーズ

用コントロールソフトの向上のため、予告なしに、画面表示及びシステム等が変更になることがあります。ま

た、バグ及び不具合等がありましたら、次回のバージョンにて修正させて頂きます。ご了承下さい。 
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MODEL400シリーズ用コントロールソフト
( Universal Control Program ) 

 

コントロールソフトの概要 

 

MODEL400シリーズ用コントロールソフト(以下 コントロールソフト)は、MODEL404，404e+，MODEL408，

408e+，MODEL416，416e+兼用のコントロールソフトです。 

下記に、主な特徴をまとめます。 

 

① MODEL404，404e+，MODEL408、408e+，MODEL416，416e+が、全て1つのコントロールソフトで操

作できる。 

② 使用の際に、便利な各種情報ツールが1つの画面上にコンパクトにまとめて表示されている。 

③ GUIを用いることにより、使用デバイス、書込みデータ、動作設定などの選択及び編集作業を容易

に扱うことができ、デバイス固有のパラメータ設定、NANDデバイス向けのパーティション設定など

のユーザーの要求に効果を発揮できる。 

④ プロジェクトファイル機能により、前回行った作業環境を素早く再現できる。 

⑤ ロット管理機能により、作業ロット数の指定及び作業レポートファイルを出力できる。 

⑥ ログ機能により、作業の進行状況を容易に確認できる。 

⑦ 自動機（ハンドラ）においてタクトタイムを向上させるコンカレントモード(サイト単位独立動作)で動

作する。 

 

 

 ※ コントロールソフトの動作環境に関する注意事項 ※ 

   本マニュアルに記載している内容について、推奨するPC環境以外においては、コントロールソフトが正

常に動作することは保証しかねます。あらかじめご了承下さい。 

 

 

※ 使用上のご注意 ※ 

① 終了する際、プログラマの主電源を切る前に、必ず、コントロールソフトを終了してからプログラマの

電源を切って下さい。プログラマの主電源を先に切ってしまうと、通信障害及びプログラマの誤作動

に繋がりますので注意して下さい。 

 

② コントロールソフトで本体を動作させる時、本体にソケットユニットは必ず装着させて下さい。また、

MODEL408，408e+，MODEL416，416e+に対してタイプの異なるソケットユニットを同時に装着するの

は故障の原因になりますのでお止め下さい。 
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コントロールソフトの起動 

 

ここからは、コントロールソフトをインストールしてからの起動を説明します。 

 

 

インストール後、デスクトップ画面上に現れるアイコン       をダブルクリックして下さい。 

 

クリック後、下記の表示が現れます。 

 

 

      

      

      

      

      

      

      

     

     

     

     

 

[ Connect a programmer ダイアログ画面 ] 

 

 

プログラマを自動検索して接続する 

起動時のモード選択画面（［Connect a programmer］ダイアログ）で［Connect］を選択し、［Select］をクリック

します。コントロールソフトは、正常に接続していれば、オンラインモードで起動し、パソコンに接続している

プログラマ本体を自動検索して通信できる状態にします。初期設定が終了すると画面上に［ONLINE］が表

示されます。 

なお、通信可能なプログラマ本体が見つからなかった場合、コントロールソフトはオフラインモードで起動

し、画面上に［OFFLINE］が表示されます。 

 

Demo modeは、プログラマを接続せずに、コントロールソフトを擬似的に動作させるためのモードです。プロ

グラマを操作する場合は、使用しないでください。 

 

MODEL 404 の Demo mode として起動する 

起動時のモード選択画面（［Connect a programmer］ダイアログ）で［Model 404］を選択し、［Select］をクリッ

クします。コントロールソフトは、MODEL 404 Demo mode で起動します。 

初期設定が終了すると画面上に［DEMO］が表示されます。 

 

 

 

MODEL 408 の Demo mode として起動する 

起動時のモード選択画面（［Connect a programmer］ダイアログ）で［Model 408］を選択し、［Select］をクリッ

クします。コントロールソフトは、MODEL 408 Demo mode で起動します。 

初期設定が終了すると画面上に［DEMO］が表示されます。 

 

 

 



MODEL400 シリーズ用コントロールソフト(Universal Control Program) 

35 

M400-020A-K8 

  

 

MODEL 416 の Demo mode として起動する 

起動時のモード選択画面（［Connect a programmer］ダイアログ）で［Model 416］を選択し、［Select］をクリッ

クします。コントロールソフトは、MODEL 416 Demo mode で起動します。 

初期設定が終了すると画面上に［DEMO］が表示されます。 

 

 

オートハンドラ（自動機）に接続するモードとして起動する 

起動時のモード選択画面（［Connect a programmer］ダイアログ）で［Use handler］を選択し、［Select］をクリ

ックします。コントロールソフトは、ハンドラ（コンカレント）モードで起動します。 

初期設定が終了すると画面上は一旦［OFFLINE］が表示されます。 

 

その後に、オートハンドラ（自動機）のアイコンをダブルクリックして下さい。 

コントロールソフトが立ち上がると同時に、オートハンドラのアプリケーションでコントロールできます。 

 

 

プログラマを接続せずに起動する 

起動時のモード選択画面（［Connect a programmer］ダイアログ）で、［Cancel］ボタンをクリックします。コント

ロールソフトは、オフラインモードで起動します。初期設定が終了すると画面上に［OFFLINE］が表示されま

す。 

画面は、MODEL404 の表示が現れます。 

 

  



MODEL400 シリーズ用コントロールソフト(Universal Control Program) 

36 

M400-020A-K8 

 

 

 
   

MODEL400コントロールソフト メイン画面の機能説明 

 

ここでは、例としてMODEL404のアプリケーション画面の機能及び動作について説明します。 

（ MODEL408、 MODEL416 については省略します。 アプリケーション画面は、各プログラマ毎に異なり

ますが、操作方法は同じです。） 

 

 

メイン画面の機能説明（例：MODEL404のメイン画面表示） 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

   

 

 

 

 

 

 

 

 

 

①  タイトルバー     
ソフト名称“UniversalControlProgram“を表示しています。 

 

 

②  メニューバー 
メニューバーには次の７つのメニューがあります。[File],[Edit],[Programmer],[Device],[Operation mode] 

[View],[Help]  

です。 

 

メニューの各項目は、すべてメニューの下にグループ化されています。 

例えば、デバイスを選択したい場合は[Device]メニューの下のオプションより[Select device…] を選択しま

す。 

 

①タイトルバー 

②メニューバー 

③ツールバー 

④プロジェクトインフォメーショ

ン 

  グループウィンドウ 

⑦プログレスコンディション 

  グループウィンドウ 

⑧ソケットステータス 

  グループウィンドウ 

⑪ステー タスバ

ー 

⑨ログウィンドウ 

⑩オペレーションパネル 

  グループウィンドウ 

⑥デバイスインフォメーション 

  グループウィンドウ 

⑤データファイル 

  グループウィンドウ 

※ 表示は一例です。 
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[File] 
 「Load Project..」（プロジェクトファイルのロード） 

 「Save Project..」（プロジェクトファイルのセーブ） 

 「Load file to buffer」（データファイルをバッファに転送） 

 「Save buffer to file」（バッファのデータを保存） 

 「Config」( 開発者設定 ),システム等の変更が出来ます。設計者のみ(パスワードあり) 

 「Control of a log file」( ログファイルの設定 ) 

 「Pass/Fail counter」(カウンタの設定) 

 「Verify check sum」（個々の ベリファイサム と期待値の比較 ） 

 「Deletion of the data file」（作業用データファイルの削除） 

 「Open log file」（ログファイルを開く） 

 「Recent File」 (過去に使用したファイル表示) 

 「Exit」 (終了) 

 

[Edit] 
 「Edit buffer」 (バッファメモリの表示／編集) 

 

[Programmer] 
 「Buzzer」（ブザーの設定） 

 「Self test」（プログラマの検査） 

 「Clear data」 （本体バッファデータの全消去） 

 「File list」 （本体バッファデータ内のファイル一覧） 

 「LED check」(LED 検査) 

 「Handler position」（ハンドラ使用時のみ：プログラマの番号の設定） 

 

[Device] 
 「Select device」(デバイス選択) 

 「Operation options..」(デバイス設定) 

 「Writing of unique ID」（ハンドラ使用時のみ：ユニークＩＤの書き込み） 

 「Copy」,「Blank check」,「Verify」,「Program」,「Erase」,「Cont」 (動作コマンド) 

 

[Operation mode] 
メイン画面上にあるスタートボタンのオペレーションを選択（ 大量生産向け ）。 

 

[View] 
 「Toolbar」（使用しません） 

 「Status Bar」（ステータスバーの表示／非表示を切り替えます） 

 「Function progress bar」（Special：エラー発生時の進捗状況を表示） 

 「Contact check NG mark」（Contact エラーの場合の、エラーマークの表示／非表示） 

 「Handler NG code」（ハンドラ使用時のみ：通常ＯＦＦ） 

 「SUM」（SUM の表示方法） 

 

[Help] 

 「About UniversalControl Program….」 （アプリケーションのバージョン表示） 

 「V_up」 (本体バージョン up)  ※設計者のみ (パスワードあり) 

 「Choice of the language」 (言語の変更) 
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404  ツールバー  ((メイン画面の機能説明)) 

 
ツールバーには６つのグループに仕切られた１７のツールがあります。グループは[プロジェクト]、[データ]、

[デバイス]、[オペレーション]、[コネクション]、[バージョン]です。 

 

[1] プロジェクトツールバー 

 

プロジェクトの読み込み 

プロジェクトファイルを開きます。開きたいプロジェクトファイルを選択し[開く]をクリックします。 

 

プロジェクトの保存 

現在の設定をプロジェクトファイルに保存します。 

 

[2] データツールバー 

 

ファイルの読み込み 

書き込み用データファイルを開きます。開きたいファイルを選択し[開く]をクリックします。 

 

ファイルの保存 

ＰＣ内バッファメモリの内容をデータファイルに保存します。 

 

バッファエディタ 

PC 内のバッファメモリの表示／編集を行います。 

 

 

[3] デバイスツールバー 

 

デバイス選択 

使用するデバイスを選択します。 

 

 

動作オプション 

デバイスのオペレーションをカスタマイズします。 

 

 

アクセス方法 

パーティションなどを設定します。 

 

 

[4] オペレーションツールバー 

 

ＣＯＰＹ 

デバイスからデータを読み出し、バッファメモリに格納します。 

 

ＢＬＡＮＫ 

デバイス内のデータが消去されているかチェックします。 
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ＶＥＲＩＦＹ 

デバイスに書き込んだデータと、バッファメモリデータを照合します。 

 

ＰＲＯＧ 

デバイスにバッファメモリデータを書き込みます。 

 

ＥＲＡＳＥ 

デバイス内のデータを消去します。 

 

ＣＯＮＴ 

ＥＲＡＳＥ、ＰＲＯＧなどのオペレーションを一括して行います。 

 

 

[5] コネクションツールバー 

 

接続 

コントロールソフト － プログラマ本体間の通信を接続します。 

 

切断 

コントロールソフト － プログラマ本体間の通信を切断します。 

 

 

[6] バージョンツールバー 

 

バージョン情報 

バージョンおよび著作権を表示します。 

 

7  プロジェクト インフォメーション グループウィンドウ  ((メイン画面の機能説明)) 

 

プロジェクトファイル名、プロジェクトＩＤ、備考を表示します。 

プロジェクトＩＤ・備考は任意の識別情報として利用できます。 

 

 

 

 

  

                                 

 

8  データファイル グループウィンドウ 

書き込みデータファイル名、メモリサイズ、チェックＳＵＭおよびＣＲＣを表示します。メモリサイズ、チェックＳ

ＵＭおよびＣＲＣはいずれもバッファメモリの内容を示します。 

（ファイルの情報ではありませんのでご注意ください） 

これらは別のファイルを読み込む、またはバッファメモリを編集するたびに更新されます。 

 

 

 

 
  

 

    

※ 表示は一例です。 

※ 表示は一例です。 
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⑥ デバイス インフォメーション グループウィンドウ 

現在選択しているデバイス型番、パッケージ名称、変換アダプタ型番、ソケットユニット名および備考を表示

します。 

 

 

 

 

 

 

 

⑦ プログレス コンディション グループウィンドウ 

作業個数（良・不良・合計）カウンタを表示します。作業ロット数が設定されている時は、 

良デバイスの個数がプログレスバーで表示され、作業の進行状況を確認できます。 

作業ロット数の設定／カウンタクリアボタンを配置しています。 

 

 

 

 

 

 

 

⑧ ソケット ステータス グループウィンドウ  ((メイン画面の機能説明)) 

サイト番号、動作中のオペレーション名、オペレーションの進行状況（プログレスバー）、ソケットステータス

を表示します。 

 

 

MODEL404、404e+では、グループウィンドウが 1 つ（ソケット 4 個）表示されます。 

 
 

MODEL408、408e+では、グループウィンドウが 2 つ（ソケット 8 個）表示されます。 

 

 
 

MODEL416、416e+では、グループウィンドウが 4 つ（ソケット 16 個）表示されます。 

 

 

※ 表示は一例です。 

※ 表示は一例です。 

※ 表示は一例です。 

※ 表示は一例です。 
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プログレスバーは、１つの（それぞれの）オペレーションの進行状況を示します。 

例：ＰＲＯＧオペレーション（１つのツールボタンでＰＲＯＧ→ＶＥＲＩＦＹと複数動作） 

ＰＲＯＧで０→１００％、ＶＥＲＩＦＹで０→１００％と変化します。 

 

 

⑨ ログウィンドウ   ((メイン画面の機能説明)) 

操作履歴（デバイスセレクト、オペレーション実行など）を表示します。ログウィンドウに表示された情報は、

ログファイルにも保存されます。保存期間などの設定をカスタマイズできます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

⑩ オペレーション パネル グループウィンドウ 

コントロールソフトの動作モードを表示、またオペレーションの実行／中断ボタンを配置しています。 

また、オペレーション中は ONLINE の下に実行中の動作モードを表示し、動作終了後、通常の表示に戻りま

す。 

 

 

 

 

 

 

 

 

オペレーションの実行ボタンは同じオペレーションを繰返し実行する時に利用できます。大きめのボタンを

配置してあり、他のオペレーションボタンを押すなどの操作ミスを防止します。 

また、オペレーション中は、Programmer state の表示が変わるだけでなく、ソケット ステータス グループウ

ィンドウのサイト表示が点滅を繰り返し、動作中であることを確認できます。 

※ 表示は一例です。 

※ 表示は一例です。 

※ 表示は一例です。 

 

 

 

オペレーション動作中 
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詳しくは、「オペレーションについて」の動作中のソケット表示をご覧下さい。 

 

 

⑪ ステータスバー 

コントロールソフトのメニューまたはツールボタンの機能の簡単な説明が表示されます。マウスポインタをメ

ニューまたはツールボタンの上に移動すると表示されます。 

ステータスバーの表示／非表示は［View -> Status Bar］で切り替えできます。 
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基本操作 
本章では以下の操作方法を説明しています 

 

 

 

設置と電源の投入 

使用するデバイスを選ぶには    

デバイスのデータを COPY するには   （COPY 動作） 

デバイスに書き込まれているデータを消すには （ERASE 動作） 

デバイスの消去状態をチェックするには  (BLANK 動作) 

デバイスへデータを書き込むには   (PROGRAM 動作) 

デバイスデータの照合をするには   （VERIFY 動作） 

連続動作を行うには    （CONT 動作） 

   コンタクトチェック, ID チェックについて 

 

 

MODEL400 シリーズは、上記の基本機能を使用するときには、専用コントロールソフトが必要です 

PC に MODEL400 用コントロールソフトをインストールして下さい。 

 

ここでは、例として MODEL404 のアプリケーション画面及び動作について説明します。 

（ MODEL408，408e+, MODEL416，416e+ については省略します。 アプリケーション画面は、各プログラ

マで異なりますが、操作方法は同じです。） 
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基本操作 

設置と電源の投入 
電源の投入までの手順および MODEL400 シリーズの設置環境について説明します。 

周囲に動力系モータを持つ機器や電気溶接機器のような電気的ノイズ源になるような機器が無いことを確

認してください。 

 

 

※ 操作前の注意事項 
MODEL400 シリーズは、水平な状態に置き、揺れや大きな振動の無い場所に設置してください。 
AC 電源ケーブルは、専用のコンセントから取り、たこ足配線は絶対に止めてください。 

このとき接地付の 3P コンセントから取ることをお勧めします。 

MODEL400 シリーズの電源スイッチが OFF になっていることを確認した後、AC 電源ケーブルを MODEL400

シリーズの背面パネルにある電源入力コネクタに差し込みます。 

デバイス及び、変換アダプタを電源投入前にセットしないでください。破損する恐れがあります。 

 

 

 

操作手順 

 

① 本体にソケットユニットを装着して下さい。 

デバイスソケットに何も挿入されていないことを確認した後、背面パネルの電源スイッチを ONにします。 

②  約 1 分待つと STATUS の LED が緑色に点灯します。点灯した時点で、PC との接続が可能になりま

す。 

③  PC 上の MODEL400 用コントロールソフトのアイコンをクリックします。 

接続のタイプの選択画面が表示します。（詳細は、操作マニュアルをご覧ください） 

(通常は、connect を選択して下さい。接続可能になります。) 

④ 前回電源を切る前に選ばれていたデバイスが自動的に呼び出され、基本画面になります 

⑤ 基本画面 

 

 

 

 

 

 

 

 

 

         

例） 画面は MODEL404 接続時の表示です。 
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タブ ( ① All , ② Only selected type , ③ Only selected manufacturer  ) 

カラムヘッダ 

デバイスリスト 

デバイス型名 入力欄 

選択ボタン 

使用するデバイスを選ぶには 

メイン画面上の [ Select device ] より 目的のデバイスを選択します。  

デバイスを効率よく選択するツールとしてセレクト デバイス ウィンドウを使用します。 

セレクト デバイス ウィンドウを開くには、[ Device ] → [ Select device ]メニューオプションを選択するか 

 

ツールバーの       をクリックします。 

 

下記のセレクト デバイス ウィンドウ画面を表示します。 

 

 

セレクト デバイス ウィンドウの操作方法   

 

 

 

     

 

 

 

 

     

 

 

 

 

 

 

 

 

 

 

 

 

表示順序を並べ替える 

カラムヘッダをクリックすると各項をアルファベットの昇順 / 降順で並べ替えができます。 

クリックするごとに昇順 / 降順が切り替わります。 

 

表示リストをスクロールする 

カラム右側にあるスクロールバーを上下にスライドすると表示リストをスクロールできます。 

 

使用デバイス確定前の選択を取り消す／変更する 

 [ｷｬﾝｾﾙ] ボタンをクリックすると選択を取り消します。 

 

 

 

対象デバイスの確定  

目的のデバイスがリスト上で見つかったらその行のチェックボックスをクリックして下さい。 
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[Select] 項にテキスト表示されます。 

 

 
 

 

最後に [OK] ボタンをクリックすると選択したデバイスが確定されます。 

確定後、対象デバイスが登録され、対象デバイスの設定に更新されます。  

 

※ 注意 ※ 

選択しているデバイスの容量によりバッファメモリ(SD)がイニシャライズ（FF,FF,…）されることがありますの

でご了承下さい。 

 

対象デバイスの検索方法について  
 

(( セレクトデバイスウィンドウ画面 )) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

① デバイス型番の一部を入力して検索範囲を絞る 

 

デバイス セレクト ウィンドウ最下部にある[Search]ボックスに 

デバイス型番の一部を入力すると検索範囲を絞ることができます。 

 

（例：“29GL“と入力すると型番に“29GL“の文字列を含むデバイスのみをリスト表示します） 

 
 

[Search] ボックスは、いずれのタブ [All] [Only selected type] [Only selected manufacture] でも使用でき

ます。 

なお、大文字／小文字を区別します。 

 

 

② デバイスタイプで検索範囲を絞る   (( セレクトデバイスウィンドウ画面 )) 

 

ウィンドウ上の [Only selected type]（デバイスタイプ）タブをクリックして選択モードを切り替えます。 

 

 
① 

② 
③ 
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検索補助エリアに[Type] [Sub type]リストボックスが表示されます。 

[Type] 項及び[Sub type] 項、共にデバイスのタイプでより細かく検索することができます。 

 

（例：[Type]項で“Flash“、[Sub type]項で“FLASH 512M-bit (x16)“を選択すると、容量 512Mbit、データ幅

16bit の NOR FLASH の 512Mbit デバイスをリスト表示します） 

 

 

 

 

 

該当するデバイスがサポートされていない場合または[Search]ボックスに何か文字列を入力している場合、

該当デバイスが見つからずリスト表示されない事があります。   

 

③ 製造メーカ名で検索範囲を絞る 

 

ウィンドウ上の [Only selected manufacture] （製造メーカ名）タブをクリックして選択モードを切り替えます。 

検索補助エリアに[Manufacture]リストボックスが表示されます。 

[Manufacture] 項で、製造メーカ名を指定できます。 

 

 

 

 

 

 

※該当するデバイスがサポートされていない場合または[Search]ボックスに何か文字列を入力している場

合、該当デ 

バイスが見つからずリスト表示されない事があります。 

 

セレクトデバイスウィンドウを閉じる 

デバイスセレクトウィンドウを閉じるには、[Cancel]ボタンをクリックするかタイトルバーの[閉じる]ボタンをク

リックします。 

この場合は、選択デバイスは変更されずにウィンドウのみ閉じられます。 
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デバイスのデータを COPYするには 

デバイスのデータを MODEL400 シリーズに COPY する時はコントロールソフトの COPY ボタンを使用しま

す。  (( COPY 動作 ))  

 

 

操作の前の注意事項！ 

1. 正常に COPY が行われたか確認する為に、チェックサムの確認を行ってください。 

2. COPY は、#1 のデバイスソケットのみ読み込みが可能です。 

#1 のソケット以外には、デバイスをセットしないでください。 

3. デバイスの実装方向が正しくないと破損する場合があります。 

 

 

 

COPY モードの操作手順 

例）M404、404e+の場合 

1. デバイス select で、デバイスを選択します。 

2. デバイスを＃１のソケットにセットします。 

3. COPY ボタンを押します。 (メイン画面のツールバー      ) 

 

COPY が実行され、正常に終了した場合は緑色の LED が点灯し、COPY が失敗したら赤色の LED が点灯

します。 

 

 

 

               

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

START

STATUS

1 2 3 4

 

TEXTOOL

248-1282-
00

PAT.No.3763489TEXTOOL

248-1282-
00

PAT.No.3763489

TEXTOOL

248-1282-
00

PAT.No.3763489TEXTOOL

248-1282-
00

PAT.No.3763489

 

A1

CBG176-101A

11×14

未使用のソケット#2,#3,#4 は赤色 LED が点灯します。 
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COPY モードの動作フローチャート 

 

 

 
 

デバイス選択 

デバイスを 

ソケット#1 に挿入 

ロックレバーを倒す 

COPY 

VERIFY 

PASS/FAIL 表示 

デバイスのピックアップ 

補足 

““Device operation option”内の設定を変更する

と、COPY 後の VERIFY をスキップすることが出来ま

す。VERIFY をスキップした場合は、必ず SUM と

CRC32 でデータの確認をしてください。 
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デバイスに書き込まれているデータを消すには 

 

電気的消去可能デバイス（EE-PROM タイプ、FLASH タイプ）に対して、書き込まれたデータを消去する時

は、コントロールソフトの ERASE ボタンを使用します。 (( ERASE 動作 )) 

 

 

操作の前の注意事項 

ソケットユニット上でコンタクトチェック又は ID チェックでＦＡＩＬになったデバイスがセットされたまま動作を実

行すると、デバイスが破損する恐れがありますので、動作前に必ず取り除いてください。 

 

 

ERASE モードの操作手順 

例）MODEL404、404e+の場合 

1. デバイス select でデバイスを選択します。 

2. データを消去したいデバイスを#1～#4 のソケットにセットします。 

3. Erase ボタンを押します。 ( メイン画面のツールバー       ) 

 

※#1～#4 のソケットにデバイスが全てセットされていると、自動的に実行されます。 

 

この時、1 ソケットでもデバイスを挿入していないソケットがあるとコントロールソフト上に警告メッセージで

“コンタクトチェックで Fail Socket があります。“の表示が現れます。デバイスを挿入していないソケットに

は赤 LED が点灯し、動作を中断します。 

 

4. 続けて実行したい時には、続行ボタンを押します。 

5. 作業終了後、LED とコントロールソフト表示により PASS/FAIL を確認します。 

6. ソケット上のデバイスを交換後、再度 ERASE を行う場合、上記のツールバーボタン以外に表示画面上

の ERASE Start ボタン、またはプログラマ本体上の START ボタンも使用することが出来ます。お客様

の作業に適した方法をご使用下さい。 
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ERASE モード動作フロー 

MODEL400 シリーズでは、下に示す順序で動作します。 

 

デバイス選択 

デバイスを 

ソケットに挿入 

ロックレバーを倒す 

 

Fail Stop 

コンタクトチェックで Fail 

Socket があります！ 

ERASE 

BLANK 

PASS/FAIL 表示 

デバイスのピックアップ 

空いているソケットがある 

全てのソケットにデバイスがある。 

補足 

“Device operation option”内

の設定を変更すると、ERASE

後の BLANK をスキップすること

が出来ます。 
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デバイスの消去状態をチェックするには 

 

デバイスが消去状態か否かを確認する時は、BLANK ボタンを使用します。 (( BLANK 動作 )) 

 

操作の前の注意事項！ 

ソケットユニット上でコンタクトチェック又は ID チェックでＦＡＩＬになったデバイスがセットされたまま動作を実

行すると、デバイスが破損する恐れがありますので、動作前に必ず取り除いてください。 

 

 

BLANK モードの操作手順 

例）MODEL404、404e+の場合 

1. デバイス select でデバイスを選択します。 

2. 消去状態を確認したいデバイスを#1～#4 のソケットにセットします。 

3. BLANK ボタンを押します。 (メイン画面のツールバー       ) 

 

※#1～#4 のソケットにデバイスが全てセットされていると、自動的に実行されます。 

 

この時、1 ソケットでもデバイスを挿入していないソケットがあるとコントロールソフト上に警告メッセージ

で“コンタクトチェックで Fail Socket があります。”の表示が現れ、デバイスを挿入していないソケットに

は赤 LED が点灯し、動作を中断します。  

 

4. 続けて実行したい時には、続行ボタンを押します。 

5. 作業終了後、LED とコントロールソフト表示により PASS/FAIL を確認してください。 

6. ソケット上のデバイスを交換後、再度 BLANK を行う場合、上記のツールバーボタン以外に表示画面上

の BLANK Start ボタン、またはプログラマ本体上の START ボタンも使用することが出来ます。お客様

の作業に適した方法をご使用下さい。 
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BLANK モード動作フロー 

MODEL400 シリーズでは、下に示す順序で動作します。 

 

 
 

デバイス選択 

デバイスを 

ソケットに挿入 

ロックレバーを倒す 

空いているソケットがある 

 

BLANK 

PASS/FAIL 表示 

デバイスのピックアップ 

Fail Stop 

コンタクトチェックで Fail 

Socket があります！ 

全てのソケットにデバイスがある。 
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デバイスへデータを書き込むには 

 

MODEL400 シリーズ内のバッファメモリ(SD)の内容をデバイスに書き込みたい時は、PROGRAM キーを使

用します。 

(( PROGRAM 動作 )) 

 

操作の前の注意事項！ 

ソケットユニット上でコンタクトチェック又は ID チェックでＦＡＩＬになったデバイスがセットされたまま動作を実

行すると、デバイスが破損する恐れがありますので、動作前に必ず取り除いてください。 

 

 

PROGRAM モードの操作手順 

例）MODEL404，404e+の場合 

1. デバイス select でデバイスを選択します。 

2. 書き込むデバイスを#1～#4 に挿入します。 

3. PROG ボタンを押します。(メイン画面のツールバー       ) 

 

※#1～#4 のソケットにデバイスが全てセットされていると、自動的に実行されます。 

 

この時、1 ソケットでもデバイスを挿入していないソケットがあるとコントロールソフト上に警告メッセージ

で“コンタクトチェックで Fail Socket があります。”の表示が現れ、デバイスを挿入していないソケットに

は赤 LED が点灯し、動作を中断します。 

 

4. 続けて実行したい時には、続行ボタンを押します。 

5. 作業終了後、LED とコントロールソフト表示により PASS/FAIL を確認してください。 

6. ソケット上のデバイスを交換後、再度 PROGRAM を行う場合、上記のツールバーボタン以外に表示画

面上の PROG Start ボタン、またはプログラマ本体上の START ボタンも使用することが出来ます。お

客様の作業に適した方法をご使用下さい。 

 

MODEL400 でサポートされた PROG 動作について 

MODEL400 では、プログラマ使用者が自分の作業に合わせた連動動作を指定出来る機能をサポートしまし

た。 

この機能は Device->operation option メニューオプションで指定出来ます。 

例１：BLANK->PROG->VERIFY 

例２：ERASE->PROG->VERIFY 

（PROG 動作の初期設定は、BLANK->ERASE->BLANK->PROG->VERIFY） 

１０５ページのオペレーションのカスタマイズ設定を参照してください。 

 

  

  



デバイスへデータを書き込むには 

55 

M400-020A-K8 

  

PROGRAM モード動作フロー 

MODEL400 シリーズでは、下に示す順序で動作します。 

 

 
 

 

デバイス選択 

デバイスを 

ソケットに挿入 

ロックレバーを倒す 

Fail Stop 

コンタクトチェックで Fail 

Socket があります！ 
ERASE 

BLANK 

PASS/FAIL 表示 

デバイスのピックアップ 

空いているソケットがある 

全てのソケットにデバイスがある。 

補足 

“Device operation option”内の設定を変更すると、

PROGRAM 前の BLANK、ERASE 及び PROGRAM

後の VERIFY をスキップすることが出来ます。 

BLANK 

PROGRAM 

VERIFY 

 

全てのデバイスが消去済。 
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デバイスデータを照合するには 

 

デバイスに書かれたデータの内容と MODEL400 シリーズのバッファメモリの内容を照合します。 

(( VERIFY 動作 )) 

 

 

操作の前の注意事項！ 

ソケットユニット上でコンタクトチェック又は ID チェックでＦＡＩＬになったデバイスがセットされたまま動作を実

行すると、デバイスが破損する恐れがありますので、動作前に必ず取り除いてください。 

 

 

VERIFY モードの操作手順 

例）M404，404e+の場合 

1. デバイス select でデバイスを選択します。 

2. データ照合をしたいデバイスを#1～#4 のソケットに挿入します。 

3. VERIFY ボタンを押します。 (メイン画面のツールバー     ) 

 

※#1～#4 のソケットにデバイスが全てセットされていると、自動的に実行されます。 

 

この時、1 ソケットでもデバイスを挿入していないソケットがあるとコントロールソフト上に警告メッセージ

で“コンタクトチェックで Fail Socket があります。”の表示が現れ、デバイスを挿入していないソケットに

は赤 LED が点灯し、動作を中断します。 

 

4. 続けて実行したい時には、続行ボタンを押します。 

5. 作業終了後、LED とコントロールソフト表示により PASS/FAIL を確認してください。 

6. ソケット上のデバイスを交換後、再度 VERIFY を行う場合、上記のツールバーボタン以外に表示画面上

の VERIFY Start ボタン、またはプログラマ本体上の START ボタンも使用することが出来ます。お客様

の作業に適した方法をご使用下さい。 
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VERIFY モードの動作フロー 

MODEL400 シリーズでは、下に示す順序で動作します。 

 

デバイス選択 

デバイスを 

ソケットに挿入 

ロックレバーを倒す 

空いているソケットがある 

VERIFY 

PASS/FAIL 表示 

デバイスのピックアップ 

Fail Stop 

コンタクトチェックで Fail 

Socket があります！ 

全てのソケットにデバイスがある。 

 



連続動作を行うには 

58 

M400-020A-K8 

 

連続動作を行うには 

 

CONT 動作は全てのプログラマで従来からサポートされてきた動作モードです。CONT ボタンは、ERASE→

BLANK→PROGRAM→VERIFY を一度に行います。 (( CONT 動作 )) 

 

MODEL404、404e+内のバッファメモリ(SD)の内容をデバイスに書き込みたい時に、弊社が推奨するデバイ

スへの動作順序をこのモードで自動的に順次実行します。 

デバイスのタイプが電気的消去（MODEL400 シリーズの ERASE モード）をサポートしている FLASH/EE-

PROM タイプと、サポートしていない EP-ROM タイプで操作手順と内部フローが異なっています。 

 

操作の前の注意事項！ 

ソケットユニット上でコンタクトチェック又は ID チェックでＦＡＩＬになったデバイスがセットされたまま動作を実

行すると、デバイスが破損する恐れがありますので、動作前に必ず取り除いてください。 

 

 

CONT モードの操作手順 

例）MODEL404，404e+の場合 

1. デバイス select でデバイスを選択します。 

2. 目的のデバイスを#1～#4 に挿入します。 

3. CONT ボタンを押します。 (メイン画面のツールバー        ) 

 

※#1～#4 のソケットにデバイスが全てセットされていると、自動的に実行されます。 

 

この時、1 ソケットでもデバイスを挿入していないソケットがあるとコントロールソフト上に警告メッセージ

で“コンタクトチェックで Fail Socket があります。”の表示が現れ、デバイスを挿入していないソケットに

は赤 LED が点灯し、動作を中断します。 

 

4. 続けて実行したい時には、続行ボタンを押します。 

5. 作業終了後、LED とコントロールソフト表示により PASS/FAIL を確認してください。 

6. ソケット上のデバイスを交換後、再度 CONT を行う場合、上記のツールバーボタン以外に表示画面上

の CONT Start ボタン、またはプログラマ本体上の START ボタンも使用することが出来ます。お客様

の作業に適した方法をご使用下さい。 
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CONT モード動作フロー1（デバイスが FLASH/EE-PROM タイプ時） 

MODEL400 シリーズでは、下に示す順序で動作します。 

 

 
 

  

デバイス選択 

デバイスを 

ソケットに挿入 

ロックレバーを倒す 

Fail Stop 

コンタクトチェックで Fail 

Socket があります！ 
ERASE 

BLANK 

PASS/FAIL 表示 

デバイスのピックアップ 

空いているソケットがある 

全てのソケットにデバイスがある。 

BLANK 

PROGRAM 

VERIFY 

全てのデバイスが消去済。 
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CONT モード動作フロー2（デバイスが EP-ROM タイプ時） 

MODEL400 シリーズでは、下に示す順序で動作します。 

 

 
 

デバイス選択 

デバイスを 

ソケットに挿入 

ロックレバーを倒す 

Fail Stop 

コンタクトチェックで Fail 

Socket があります！ 

PASS/FAIL 表示 

デバイスのピックアップ 

空いているソケットがある 

全てのソケットにデバイスがある。 

BLANK 

PROGRAM 

VERIFY 
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コンタクトチェック、IDチェックについて 

 

コンタクトチェック 

対象デバイスとプログラマ間の物理的な接続が正しく行われているかをチェックする機能です。 

全てのオペレーションの前に実行されます。 

コンタクトチェックあり／なし設定は、カスタマイズできますが、特別な目的がない限りコンタクトチェックあり

でオペレーションする事を推奨します。 

 

詳しくは、「オペレーションのカスタマイズ設定」を参照してください。 

なお、コンタクトチェックのみを行うメニューオプションおよびツールボタンはありません。 

 

 

ID チェック 

実際に使用するデバイスが選択した対象デバイスであるかどうかを電気的にチェックする機能です。デバイ

スＩＤを持つデバイスでは、全てのオペレーションの前に実行されます。 

デバイスＩＤチェックあり／なし設定は、カスタマイズできますが、特別な目的がない限り、ID チェックありでオ

ペレーションする事を推奨します。 

 

詳しくは、「オペレーションのカスタマイズ設定」を参照してください。 

なお、デバイスＩＤチェックのみを行うメニューオプションおよびツールボタンはありません。 

 

 

プロテクト 

対象デバイスがプロテクトに対応している場合は「Option」プロテクトを行うセクタを設定するであるかどうか

を電気的にチェックする機能です。デバイスＩＤを持つデバイスでは、全てのオペレーションの前に実行され

ます。 

 

詳しくは、「オペレーションのカスタマイズ設定」を参照してください。 

なお、デバイスＩＤチェックのみを行うメニューオプションおよびツールボタンはありません。 
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①プロテクト チェックボックス 

③選択ボタン 

②プロテクト設定欄 

プロテクトについて 

 

対象デバイスがセクタプロテクト、ロックビットなどに対応している場合、オプション設定画面で設定すること

ができます。 

 

オプション画面上の [ Device operation options ] より [ Sector protection ] で設定をします。  

 

オプション ウィンドウを開くには、[ Device ] → [ Operation options... ]を選択するか 

 

ツールバーの       をクリックします。 

 

下記のオプション ウィンドウ画面を表示します。 

 

 

プロテクトの設定方法   

 

        
 

 

 

 

① Protect/Unprotect のプロテクト チェックボックスにチェックを入れます。 

② プロテクト設定欄にプロテクトするセクタ番号を入れます。（non（デフォルト）はセクタ指定なし） 

（Example ： Sector 2,3,15,16,17 を指定時は 「2,3,15-17」と入れます） 

③ 選択ボタン OK を押します。
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機能説明 

本章では以下の機能について説明しています 

 

 

データファイルの転送   

データファイルの保存   

バッファエディタ (Edit) について  

プロジェクト管理機能について  

   ロット管理機能について   

   作業の進行状況確認について  

   プログラマ本体の設定について 

   オペレーションについて 

 

 

MODEL400 シリーズは、上記の基本機能を使用することで多彩なパフォーマンスができます。 

 

ここでは、例として MODEL404，404e+のアプリケーション画面及び動作について説明します。 

（ MODEL408，408e+, MODEL416，416e+ については省略します。 アプリケーション画面は、各

プログラマで 

異なりますが、操作方法は同じです。） 

 

 



データファイルの転送 

64 

M400-020A-K8 

 

 

データファイルの転送 

デバイスへのオペレーションを行うには、ＰＣ内 及び プログラマ本体に書込みデータをセットする必要があ

ります。 

書込みデータをセットする前には、必ず対象デバイスを選択してから書込みデータをセットして下さい。 

 

データファイルの読込み 
データファイルを読込むには、[File] -> [Load file to buffer]メニューオプションを選択するか、ツールバーの

(ロード)  

ボタン  をクリックします。 

クリック後、下記の Load file ダイアログが現れます。 

 

[ Browse ]ボタンを押すことでデータファイルの格納場所を検索することができ、選択することができます。 

選択し終わったら「File name」にデータファイル名が記載されます。 

記載されていれば、[ Load ]ボタンを押すことでデータファイルをロードすることが出来ます。 

 

 

Load file ダイアログの操作方法 

 

Load file ダイアログ 

 

      

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

②ファイルフォーマット 

③付加オプション 

(スワップ, バッファクリア) 

④バッファオフセット 

①ファイルネーム 
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① ファイル名を選ぶ 

Load file ダイアログの[File name]ボックスにファイル名を入力します。 

[Browse]ボタンでファイルフォルダを指定することができます。 

 

※ デフォルトファイルフォルダ 

 [Browse] ボタンでファイルフォルダを指定した場合は、以降そのフォルダがデフォルトフォルダになりま

す。 

 

 

404 ファイルフォーマットを選ぶ 

ロードするファイルの書式（ファイルフォーマット）を指定します。 

Load file ダイアログの[Format type]リストにて使用するファイルのフォーマットを選択します。 

 

フォーマットは、モトローラ (*.MOT) 、インテルＨＥＸ (*.HEX) に対応しています。それ以外は NO フォーマ

ット（フォーマットなし、書き込みデータのみ）として取り扱います。 

 

7 付加オプション 

・ スワップして読込む 

ファイルロード時にデータをバイトスワップするには、Load file ダイアログの[Swap byte]チェックボックス

([additional option]グループ内)をチェックします。 

（ ワードスワップおよびビットスワップは開発中です。 ） 

 

・ バッファを消去してから読み込む 

ファイルロード時に格納先のＰＣ内バッファメモリの全範囲を消去するには、Load file ダイアログの[Erase 

buffer before loading]チェックボックス([additional option]グループ内)をチェックします。 

及び、[Erase value]ボックスに希望する消去値を入力します。 

（ デフォルトは、消去あり／消去値ＦＦｈです。 ） 
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8 バッファオフセット  [ デフォルト（None） ] 

バッファオフセットでは、ファイルから読み込んだデータをバッファに入れる時のオフセットアドレスが指定出

来ます。標準設定は“None“になります。ユーザーが使用する時にオフセット値を設定して下さい。 

次の設定が出来ます。 

 

None：読み込んだファイルはオフセット無しでバッファメモリに入ります。 

格納開始番地を調整することができます。 

格納開始番地を調整するには、Load file ダイアログの [buffer offset for loading] を設定します。 

 

Positive offset：読み込んだファイルアドレスにオフセット値を加算したバッファアドレスにデータをストアしま

す。 

バッファアドレス = フォーマットアドレス＋オフセットアドレス 

 

Negative offset：読み込んだファイルアドレスオフセット値を引き算したバッファアドレスにデータをストアしま

す。 

バッファアドレス = フォーマットアドレス－ネガティブオフセット 

 

Automatic negative offset：この設定では読み込むファイルから自動的にオフセット値を検出して使用しま

す。 

バッファアドレス = フォーマットアドレス－ネガティブオフセット 

 

ファイルロード補足 
ロードが完了すると、メイン画面の データ ファイル グループの表示（SUM／CRC）などが更新されます。 

その後、データファイルをプログラマに転送するかどうかのメッセージが表示されますので、必要に応じて

[はい]／[いいえ]を押してください。 

 

プログラマ本体内に使用履歴があるかないかにより２種類のメッセージが表示されます。(下記表記) 

 

これは、プログラマ本体のバッファメモリ(SD)に使用データが残っており、ファイルを効率良くロードできる機

能です。データをバッファメモリ(SD)に残したくない場合は、消去することもできます。 

 

※ バッファメモリ(SD)の使用データに関して、バッファメモリ(SD)に保存しているデータが万一、流出、削除

等されても弊社は保証致しかねますので注意して下さい。 
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データ ファイル ロードの２種類のメッセージについて ((データファイルのロード使用履歴)) 

 

使用履歴なし 

 
このファイルは過去に使用した事がありませんのでプログラマ本体に転送する必要があります。 

メッセージが表示された場合は[はい]ボタンをクリックして下さい。 

また、ファイルの使用履歴（[Programmer]->[Clear Data]）を消去した場合もこのダイアログが表示されま

す。 

 

 

使用履歴あり 

 
このファイルは過去に使用した事があります。[いいえ] ボタンをクリックすると、プログラマ本体へのデータ

転送は行わずに本体内のバックアップデータを使用します。 

データ転送を行わないため、プログラマの設定にかかる作業時間を短縮できます。 

あらためて本体内へデータを転送する場合は、[はい]ボタンを押してください。 

 

 

Load file ダイアログを閉じる 

Load file ダイアログを閉じるには、[Cancel]ボタンをクリックするかタイトルバーの[閉じる]ボタンをクリックし

ます。 

この場合は、データファイルは変更されずにダイアログのみ閉じられます。 
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データファイルの保存 

 

Edit 画面上で加工したデータまたは、デバイスから COPY したデータなど、ファイルとして保存することがで

きます。 

 

データファイルに保存するには、[File] -> [Save buffer to file]メニューオプションを選択するか、ツールバー

の(セーブ)ボタン  をクリックします。 

 

クリック後、Save buffer ダイアログが現れます。 

[ Browse ] を押すことで保存先, ファイル名を指定することができます。 

 

[ File name ], [ Fomat type ], [ Advanced save options ], [ Additional option ] ( 機能については下記にて

説明します )に変更がなければ [ Save ]を押すことでデータファイルが保存されます。 

 

Save buffer ダイアログの画面操作方法 

 

Save buffer ダイアログ 

 

 

 

 

 

 

 

 

 

 

 

①  ファイル名を記入する 

Save buffer ダイアログの[File name]ボックスにファイル名を入力します。 

ファイルを保存する場合は[Browse]ボタンでファイルフォルダを指定できます。 

※ ファイルフォルダを指定した場合は、以降そのフォルダがデフォルトになります。 

 

② ファイルフォーマットを選ぶ 

セーブするファイルの書式（ファイルフォーマット）を指定します。 

Save buffer ダイアログの[Format type]リストにて保存するファイルのフォーマットを選択します。 

 

フォーマットは、モトローラ (*.MOT) 、インテルＨＥＸ (*.HEX) に対応しています。それ以外は NO フォー

マット（フォーマットなし、書き込みデータのみ）として取り扱います。 

 

③ 付加オプション 

スワップして保存する 

ファイル保存時にデータをバイトスワップするには、Save buffer ダイアログの[Swap byte]チェックボックス

をチェックします。 

ワードスワップおよびビットスワップは開発中です。 

 

① ファイル名 

② フォーマットタイプ 

③ 付加オプション 
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保存番地を変更する 

ＰＣ内バッファの一部の範囲のみを保存したい場合に、[Buffer start]および[Buffer end]ボックスのアドレ

スを編集します。また、これらのアドレスはバイトアドレスで表示されています。編集する場合もバイトアド

レスで入力してください。 

 

ファイルを保存する 

Save buffer ダイアログの[Save]ボタンをクリックすると、ファイルの保存を開始します。保存が完了する

と、メイン画面のデータ ファイルグループの表示（SUM／ＣＲＣ）などが更新されます。 

その後、データファイルをプログラマに転送するかどうかのメッセージが表示されますので、必要に応じて

[はい]／[いいえ]を押してください。 

 

プログラマ本体内に同一ファイルの使用履歴があるかないかにより２種類のメッセージが表示されます。 

詳しくは、「データファイルのロード使用履歴」を参照してください。 

 

 

Save buffer ダイアログを閉じる 

Save buffer ダイアログを閉じるには、[Cancel]ボタンをクリックするかタイトルバーの[閉じる]ボタンをクリ

ックします。 この場合は、データファイルは変更されずにダイアログのみ閉じられます。 
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①メニューバー 
②ツールバー 

 

③データ表示領域 

 

バッファエディタ（PC内のバッファエディタ） (Edit) について 

特徴 

バッファメモリの初期化、検索、および編集などを容易に行うための各種ツールを持っています。 

 

メイン画面上の      をクリックすることでエディタを利用することができます。 

 

リファレンス 

メニュー [Function] [View] [Help] 

ツールバー [初期化] [加工] [検索・置換] [ジャンプ] [モード] [Check SUM] [バージョン] 

 

ファイル転送に関する注意事項 

バッファエディタはバッファメモリデータ（PC 内バッファ）の操作を行うツールです。 

実際にデバイスへのオペレーションを行う場合は、バッファエディタ終了後にプログラマ本体にもデータを

転送する必要があります。 

詳しくは、「COPY 動作」又は「データファイルの転送」を参照してください。 

 

エディタウィンドウの操作方法について説明します。  ((エディタウィンドウ画面)) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

④ ステータスバー 
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① メニューバー 

メニューバーには次の３つのメニューがあります。[Function] 、 [View] 、 [Help] です。 

メニューのオプションは、すべてこれらメニューの下にグループ化されています。 

 

[Function] ・・・・ 機能一覧 

ツールバーに表示している機能をまとめています。（機能は下記にて説明） 

 

[View] ・・・・・ エディタ表示変更 

Toolbar, status bar, Byte, Word の表示変更ができます。 (Toolbar の変更はできません。) 

 

 

バイト単位で表示 (Byte) 

バッファの内容をバイト単位で表示するには、[View] -> [Byte]メニューオプションを選択します。バッファ

エディタを開く時は、常にバイト単位表示モードになります。 

表示はバイト単位で表示されますが、データそのものは変更されません。 

 

 

 

ワード単位で表示 (Word) 

バッファの内容をワード単位で表示するには、[View] -> [Word]メニューオプションを選択します。リトルエ

ンディアン方式のワード表示です。 

表示はワード単位で表示されますが、データそのものは変更されません。  

バッファエディタを再び開く時は、バイト単位表示モードに戻ります。 

 

 

 

② ツールバー  ( エディタウィンドウ画面 ) 

ツールバーには７つのグループに仕切られた 13 のツールがあります。グループは[初期化]、[加工]、[検

索・置換]、[ジャンプ]、[モード]、[チェックＳＵＭ] 、[バージョン]です。 

ツールバーの表示／非表示は［View -> Toolbar］で切り替えできます。  

 

ツールバーの詳しい説明を 「ツールバーの機能説明」にて記載しています。 

 

 

[1] 初期化ツールバーボタン  

 

Erase buffer 

PC 内バッファメモリを“ＦＦｈ”で初期化します。 

 

Fill random data 

PC 内バッファメモリをランダムデータで初期化します。 

 

Fill block 

PC 内バッファメモリを指定データ列で初期化します。 

 

[2] 加工ツールバーボタン  

 

Copy block 

PC 内バッファメモリの一部の範囲をコピーし、別の番地に貼り付けます。 
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Move block 

PC 内バッファメモリの一部の範囲を切り取り、別の番地に貼り付けます。 

 

Swap data in block 

PC 内バッファメモリデータを並べ替えます。 

 

 

[3] 検索・置換ツールバーボタン  

 

Find text 

指定データ列を検索します。 

 

Replace text 

データ列を検索し、指定データ列で置換します。 

 

 

[4] ジャンプツールバーボタン  

 

Go to Address   

指定アドレスにジャンプします。 

 

 

[5] モードツールバーボタン  

 

Edit buffer 

バッファエディタを編集モードに切り替えます。ウィンドウに表示されるデータを書替えることができま

す。 

 

View buffer 

バッファエディタを閲覧モードに切り替えます。ウィンドウに表示されるデータは書替えできません。 

 

 

[6] Checksum ツールバーボタン  

 

Check SUM 

ＳＵＭ・ＣＲＣを計算します。 

 

 

 

 

[7] バージョンツールバーボタン 

 

About 

バージョンおよび著作権を表示します。 
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③データ表示領域  ( エディタウィンドウ画面 ) 

PC 内バッファメモリの内容を表示します。デフォルトでは、バイト単位で表示されます。対象デバイスによっ

て最大３つのタブを持ちます。 

タブに表示される名前は、デバイス内のデータ領域の種類を示します。（デバイスによって名前が変わる場

合があります。）タブをクリックすると表示を切り替えます。 

なお、各タブに表示されるデータは、それぞれ独立しています。ある番地のデータが他のタブ上で重複して

表示されることはありません。 

 

 
 

 

④ステータスバー   

バッファエディタのメニューまたはツールボタンの簡単な機能説明が表示されます。マウスポインタをメニュ

ーまたはツールボタンの上に移動すると表示されます。 

ステータスバーの表示／非表示は［View -> Status Bar］で切り替えできます。 
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ツールバーの機能説明 
 

バッファメモリデータを消去   ( エディタウィンドウ画面 ) 

バッファメモリデータを消去するには、[Function] -> [Erase buffer]メニューオプションを選択するか、 

 

ツールバーの（バッファ消去）ボタン  をクリックします。 

その後表示される、Continue ダイアログの [はい] ボタンをクリックする 

と初期化を開始します。 

バッファメモリは全範囲“ＦＦｈ”データで消去（初期化）されます。 

 

[いいえ] ボタンをクリックすると変更されず、そのまま終了します。 

 

 

 

ランダムデータでバッファメモリを初期化   

バッファメモリ データをランダムに書き替える（ランダムデータで初期化）には、[Function] -> [Fill random 

data]メニューオプションを選択するか、ツールバーの（ランダムデータ）ボタン  をクリックします。 

その後表示される、Continue ダイアログの[OK]ボタンをクリックすると 

初期化を開始します。 

バッファメモリは全範囲、ランダムなデータで書き替え（初期化）られます。 

 

[いいえ] ボタンをクリックすると変更されず、そのまま終了します。 

 

 

 

指定データでバッファメモリを初期化 

バッファメモリデータを指定データで初期化するには、[Function] -> [Fill block]メニューオプションを選択す

るか、 

ツールバーの（Fill block）ボタン  をクリックします。 

その後表示されるダイアログ内に初期化アドレスと初期化データを入力し、[OK]ボタンをクリックすると初期

化を開始します。 

 

 

 

 

 

 

 

 

 

 

 

初期化オプションとして、アドレス範囲、初期化データ（文字列データ、またはＨＥＸデータ列）を指定できま

す。 

 

①アドレス範囲を指定する 

 

①アドレス範囲を指定 

②文字列データ（ＡＳＣＩＩ）で初期化 

③１６進データ列（ＨＥＸ）で初期化 

 

① 

② 

③ 

 

 

（日本語表示の場合） 

 

（日本語表示の場合） 
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アドレス範囲を指定したい場合に、[Block start] および[Block end]ボックスのアドレスを編集します。 

これらのアドレスはバイトアドレスで表示されています。編集する場合もバイトアドレスで入力してください。 

 

②文字列データ（ＡＳＣＩＩ）で初期化する 

文字列データ（ＡＳＣＩＩ）で初期化したい場合に、[Ascii]ボックスの文字列（[Fill string (Max 16)]グループ内）

を編集します。最大１６文字まで指定できます。 

 

③１６進データ列（ＨＥＸ）で初期化する 

１６進データ列（ＨＥＸ）で初期化したい場合に、[Hex]ボックスのデータ列（[Fill string (Max 16)]グループ内）

を編集します。最大１６バイトまで指定できます。 

 

 

  



バッファエディタ 

76 

M400-020A-K8 

 

データの一部をコピー  ( エディタウィンドウ画面 )  

バッファメモリデータの一部をコピーして別の番地以降に上書きします。 

コピーするには、[Function] -> [Copy block]メニューオプションを選択するか、ツールバーの 

（Copy block）ボタン  をクリックします。 

その後表示されるダイアログ内にコピーアドレスを入力し、[OK]ボタンをクリックするとコピーを開始します。 

 

 

 

 

 

 

 

 

① コピー元アドレス範囲を指定する 

コピー元アドレス範囲を指定するには、[Block start]および[Block end]ボックスのアドレスを編集します。

これらのアドレスはバイトアドレスで表示されています。編集する場合もバイトアドレスで入力してくださ

い。 

 

② コピー先開始アドレスを指定する 

コピー先開始アドレスを指定するには、[Destination]ボックスのアドレスを編集します。これらのアドレス

は、バイトアドレスで表示されています。編集する場合もバイトアドレスで入力してください。 

 

Copy block ダイアログを閉じる 

Copy block ダイアログを閉じるには、[Cancel]ボタンをクリックするかタイトルバーの[閉じる]ボタンをクリ

ックします。 

この場合は、バッファデータは変更されずにダイアログのみ閉じられます。 

 

※ 上書き範囲がバッファサイズを越える場合 

バッファサイズを超える部分には、データの上書きはしません。 

 

  

 

① 

② 
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データの一部を移動  ( エディタウィンドウ画面 ) 

バッファメモリデータの一部を切り取り、別の番地に上書きします。 

移動するには、[Function] -> [Move block]メニューオプションを選択するか、ツールバーの（Move block） 

ボタン  をクリックします。 

 

その後表示されるダイアログ内に切り取り部分のアドレスと移動先を入力し、[OK]ボタンをクリックすると移

動を開始します。 

 

 

 

 

 

 

 

切り取った範囲のデータは“ＦＦｈ”で埋められます。 

 

 

① 切り取りアドレス範囲を指定する 

切り取りアドレス範囲を指定するには、[Block start]および[Block end]ボックスのアドレスを編集します。 

これらのアドレスはバイトアドレスで表示されています。編集する場合もバイトアドレスで入力して下さ

い。 

 

 

② 移動先開始アドレスを指定する 

移動先開始アドレスを指定するには、[Destination]ボックスのアドレスを編集します。これらのアドレスは

バイトアドレスで表示されています。編集する場合もバイトアドレスで入力して下さい。 

 

 

Move block ダイアログを閉じる 

Move block ダイアログを閉じるには、[Cancel]ボタンをクリックするかタイトルバーの[閉じる]ボタンをクリ

ックします。 

この場合は、バッファデータは変更されずにダイアログのみ閉じられます。 

 

 

※ 上書き範囲がバッファサイズを越える場合 

バッファサイズを超える部分には、データの上書きはしません。 

 

  

 

① 
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データの一部を入れ替える（SWAP） ( エディタウィンドウ画面 ) 

 

バッファメモリ データの入れ替えをします。主に、書き込みデータとデバイスのエンディアン調整のために

行われます。 

SWAP するには、[Function] -> [Swap data in block]メニューオプションを選択するか、ツールバーの（スワッ

プデータ）ボタン  をクリックします。 

 

その後表示されるダイアログ内に Swap アドレスと Swap モードを指定し、[OK]ボタンをクリックすると入れ替

えを開始します。 

 

 

 

 

 

 

 

 

 

 

 

① 入れ替えるアドレスを [ Block start ],[ Block end ]に入力して場所を指定します。 

 

② 入れ替えの方法について 

 

2-byte スワップ（エンディアン変換） 

[Swap 2-bytes inside 16-bit words]：バッファメモリデータをバイト単位でスワップします。 

例：[A],[B], [C],[D] 2-bytes swap [B],[A], [D],[C] ：[ ]はバイトサイズ 

 

4-byte スワップ（4byte データを入れ替え） 

[Swap 4-bytes inside 32-bit words]：バッファメモリデータを 4byte 単位で並び順をスワップします。 

例：[A],[B], [C],[D] 4-bytes swap [C],[D], [A],[B]  ：[ ]はバイトサイズ 

 

ニブルスワップ（上位 4bit-下位 4bit を入れ替え） 

[Swap nibbles inside byte]：バッファメモリデータを各 1byte の上下 4bit をスワップします。 

例：[00101101] swap nibbles [11010010]  ：[ ]はバイトサイズ 

 

Swap data in block ダイアログを閉じる 

Swap data in block ダイアログを閉じるには、[Cancel]ボタンをクリックするかタイトルバーの[閉じる]ボタ

ンをクリックします。 

この場合は、バッファデータは変更されずにダイアログのみ閉じられます。 

 

 

  

 

① 
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データを検索  ( エディタウィンドウ画面 ) 

PC 内バッファのデータを検索するには、[Function] -> [Find text]メニューオプションを選択するか、ツール

バーの（データ検索）ボタン  をクリックします。 

その後表示されるダイアログ内に検索する文字列またはデータ列を入力し、[Find]ボタンをクリックすると検

索を開始します。 

 

  

           

 

 

 

 

 

 

検索オプションとして、検索データ（文字列データ、またはＨＥＸデータ列）、検索方向、検索開始位置を指定

できます。 

 

①検索するデータを入力します 

Hex 側ボックス：検索したいデータを 16 進データ列で入力します。 

Ascii 側ボックス：検索したいデータを ASCII 文字列で入力します。 

 

②検索方向を指定する 

検索を進めていく方向を指定できます。Forward（順方向）または Backward（逆）（ [Direction] グループ内）

を選択します。 

Forward（順方向）は、先頭アドレス（０番地）から最終アドレスの方向に検索します。 

Backward（逆）は、最終アドレスから先頭アドレス（０番地）の方向に検索します。 

 

検索開始位置を指定する 

検索を開始する位置を指定できます。From cursor（現在のカーソル位置）または Entire scope（全体）

（ [Origin] グループ内）を選択します。 

From cursor は、現在のカーソル位置から開始します。 

Entire scope は、検索方向に連動して先頭アドレス（０番地）または、最終アドレスから開始します。 

 

Find text ダイアログを閉じる 

Find text ダイアログを閉じるには、[Cancel]ボタンをクリックするかタイトルバーの[閉じる]ボタンをクリックし

ます。 この場合は、検索されずにダイアログのみ閉じられます。 

 

  

 

① 

② 
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データを置換する  ( エディタウィンドウ画面 ) 

PC 内バッファのデータを指定データ（列）で検索し、見つかった場合はそれを別のデータに置き換えます。 

使用するには、[Function] -> [Replace text]  メニューオプションを選択するか、ツールバーの（Replace 

text）ボタン  をクリックします。 

その後表示されるダイアログ内に検索する文字列と置換するデータ列を入力し、 [Replace]ボタンをクリッ

クするとデータの検索と置換を開始します。 

 

 

 

 

 

 

 

 

 

 

 

 

① 検索オプション 

検索データを入力します。 

Hex 側ボックス：検索したいデータを 16 進データ列で入力します。 

Ascii 側ボックス：検索したいデータを ASCII 文字列で入力します。 

 

② 置換オプション 

置換データを入力します。 

Hex 側ボックス：置換したいデータを 16 進データ列で入力します。 

Ascii 側ボックス：置換したいデータを ASCII 文字列で入力します。 

 

③ 検索方向を指定する 

検索を進めていく方向を指定できます。Forward（順方向）または Backward（逆）（ [Direction] グループ

内）を選択します。 

Forward（順方向）は、先頭アドレス（０番地）から最終アドレスの方向に検索します。 

Backward（逆）は、最終アドレスから先頭アドレス（０番地）の方向に検索します。 

 

検索開始位置を指定する 

検索を開始する位置を指定できます。From cursor（現在のカーソル位置）または Entire scope（全体）

（ [Origin] グループ内）を選択します。 

From cursor は、現在のカーソル位置から開始します。 

Entire scope は、検索方向に連動して先頭アドレス（０番地）または、最終アドレスから開始します。 

 

④ 置換の処理設定 

全範囲の置換を行うか、１個置換毎に確認作業を行うかを選択します。 

Next 指定時：１回の置換処理毎に確認画面を表示します。 

このモードでは、１回の置換処理が終わる毎に“次の置換を行うかどうか”を問い合わせるメッセージが

表示されます。続けて置換を行う場合は[はい]ボタンを、ここで終了する場合は[いいえ]ボタンをクリック

します。 

All 指定時：全範囲の置換処理を行います。確認の問い合わせはありません。 

 

 

① 検索オプション 

② 置換オプション 

③ 検索方向を指定 ④ 置換の処理設定 
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Replace text ダイアログを閉じる 

Replace text ダイアログを閉じるには、[Cancel]ボタンをクリックするかタイトルバーの[閉じる]ボタンをク

リックします。 

この場合は、バッファデータは変更されずにダイアログのみ閉じられます。 
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指定アドレスにジャンプする  ( エディタウィンドウ画面 ) 

PC 内バッファの指定アドレスにジャンプし、データを表示するには、[Function] -> [Go to Address]メニュ

ーオプションを選択するか、ツールバーの（Go to address）ボタン  をクリックします。 

その後表示される、Go to address ダイアログの[OK]ボタンをクリックすると指定アドレスにジャンプしま

す。 

 
 

ジャンプ先表示アドレスを指定する 

ジャンプ先表示アドレスを指定するには、[Current address]ボックスにアドレスを入力します。アドレスは

バイトアドレスで表示されています。編集する場合もバイトアドレスで入力して下さい。 
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編集モードに切り替える （EDIT モード）  

バッファエディタを編集モードに切り替えるには、[Function] -> [Edit buffer]メニューオプションを選択する

か、ツールバーの（Edit buffer）ボタン  をクリックします。 

 

編集モードに切り替わると、[Edit buffer]メニューオプション及び（Edit buffer）ボタンが選択できない（選択

禁止）状態に変わります。 

その後、データ表示領域にカーソルが移動し、カーソル位置にあるデータを編集できるようになります。１

６進データ（ＨＥＸ）のキー（０－９、Ａ－Ｆ）を受け付けます。 

また編集モード時は、データ表示領域内を[↑] [↓] [←] [→]キーで移動できます。 

マウスをクリックしてカーソルを直接移動することもできます。 

 

なお、バッファデータの変更は[OK]または[Update]などのボタンなしに直ちに適用されます。 

バッファエディタを再び開く時は、閲覧モードに戻ります。 
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閲覧モードに切り替える (VIEW モード)  ( エディタウィンドウ画面 ) 

バッファエディタを閲覧モードに切り替えるには、[Function] -> [View buffer]メニューオプションを選択す

るか、ツールバーの（View buffer）ボタン をクリックします。 

閲覧モードに切り替わると、[View buffer]メニューオプションおよび（View buffer）ボタンが選択できない

（選択禁止）状態に変わります。 

 

 
 

バッファエディタを開いた直後は、常に閲覧モードになります。 
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SUM、CRC、XOR を確認する 

バッファエディタでは、バッファデータの各種ＳＵＭ、ＣＲＣ、ＸＯＲを確認できます。 

対応している形式は７つあります。バイトサム、ワードサム (リトルエンディアン)、ワードサム (ビッグエン

ディアン)、ＣＲＣ１６、ＣＲＣ３２、ＣＲＣ－ＣＣＩＴＴ、ＸＯＲです。 

ＳＵＭ、ＣＲＣ、ＸＯＲは主に、ロードしたファイルデータが正しいかどうか、またはデバイスに書き込むデー

タが正しいかどうかの識別・検証に用います。 

 

ＳＵＭ、ＣＲＣ、ＸＯＲを確認するには、[Function] -> [Check sum]メニューオプションを選択するか、ツール

バーの（チェックサム）ボタン  をクリックします。 

その後表示される、Checksum ダイアログの[Calculate]ボタンをクリックすると演算を開始します。 

 

 
 

※ 演算するアドレス範囲を指定する必要があります。 

 

①  演算アドレス範囲を指定する 

演算アドレス範囲を指定するには、[From address]および[To address]ボックスのアドレスを編集します。こ

れらのアドレスはバイトアドレスで表示されています。編集する場合もバイトアドレスで入力して下さい 

デフォルトで全範囲が指定されていますので、よければ、このまま[Calculate]ボタンをクリックして下さい。 

 

②  SUM、CRC、XOR の表示 

演算アドレス範囲を指定し、[Calculate]ボタンを押すことでアドレス範囲までの SUM、CRC、XOR を確認す

ることができます。 ※デフォルトで全範囲が指定されています 

 

Checksum ダイアログを閉じる 

Checksum ダイアログを閉じるには、[Cancel]ボタンをクリックするかタイトルバーの[閉じる]ボタンをクリック

します。 

 

バッファエディタを終了する 

バッファエディタを終了するには [Function -> Exit] を選択するか、 [Alt]+[F4] キーを押すか、タイトルバ

ーの閉じるアイコンをクリックして下さい。 

 

データ編集を行う場合は、バッファエディタを終了する時に注意してください。 

 

データの編集を行ってからバッファエディタを終了する時、コントロールソフトはデータが編集されていると 

「バッファメモリが更新されています！データを転送しますか？」のメッセージを表示します。 

ここで [はい]を選択してください。ファイル名 = [ EDIT_DATA ] として編集したデータがプログラマのバッフ

ァメモリに転送されます。 

② SUM、CRC、XOR の表示 

① 演算アドレス範囲 
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 [いいえ]を選択した場合は、プログラマには転送しません。 

プログラマへ転送しなかった場合、バッファエディタで表示するデータと、プログラマがデバイスにリード／書

き込みするデータが一致しませんので注意して下さい。プログラマがリード／書き込みするデータはエディ

タ作業をする前のデータ（プログラマに転送されているデータ）が使用されます。 

 

 

編集したデータをファイルに保存する 

 

編集したデータをファイルに保存するには、一旦バッファエディタを終了してください。 

その後、メイン画面から File->Save buffer to file メニューオプションまたは保存ツールボタンを使用してくだ

さい。 

 

 ((データファイルの保存)) 
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プロジェクト管理機能について 

 

MODEL400 用コントロールソフトでは、作業で使用したデバイス、書き込みデータなどの作業環境をプロジェ

クトファイルに保存し、次回作業を行う時に作業環境を前回の設定に再現できます。 

 

関連項目 

((プロジェクトファイルに保存される設定)) 

 

 

プロジェクトファイルを読み込む 

プロジェクトファイルをコントロールソフトに読み込むには、[File] -> [Load project]メニューオプションを選択

するか、ツールバーの（Load project）ボタン  をクリックします。 

その後表示されるダイアログ内から使用するプロジェクトファイルを指定し、[開く]ボタンをクリックするとプロ

ジェクトファイルの読み込みを開始します。 

 

ファイル拡張子 

プロジェクトファイル拡張子は、xxxx．Ppf です。 

 

 

作業環境をプロジェクトファイルに保存する  

 

現在の作業環境をプロジェクトファイルに保存するには、[File] -> [Save project]メニューオプションを 

選択するか、ツールバーの（Save project）ボタン  をクリックします。 

現在のプログラマ動作 mode、デバイス名、データファイル名、チェック sum 値等が Project->Confirmation

ダイアログに表示されます。 

Protection of the file in the SD ： プログラマにファイルを読み込む場合、プログラマ内のＳＤメモリの容量

が不足していると、以前に読み込んだファイルが削除されます。但し、ここで Protection of the file in the 

SD にチェックを入れておくと削除されません。 

 
内容を確認後、“OK“ボタンをクリックして下さい。 

Project information ダイアログが表示されます。 

以下に Project information ダイアログの画面の操作方法を示します。 

 

 

Project information ダイアログ 
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404  ファイル名 

7  プロジェクト ID 

8  備考欄 
              

 

 

 

 

①  使用するプロジェクトファイル名を入力する 

Project information ダイアログの[Proj file name]ボックスにファイル名を入力します。デフォルトのファイ

ルフォルダ以外にファイルが存在する場合は[Browse]ボタンでファイルフォルダを指定できます。 

 

※ デフォルトフォルダは“C:\programmer\m404\support\data“ です。 

[Browse] ボタンでファイルフォルダを指定した場合は、以降そのフォルダがデフォルトになります。 

 

 

② プロジェクトＩＤを入力する 

プロジェクトの識別・検証情報として任意のプロジェクトＩＤを追加できます。 

Project information ダイアログの[Project ID]ボックスにＩＤを入力します。 

入力可能文字は英数半角で最大１６文字です。 

 

 

③ 備考を入力する 

プロジェクトの識別・検証情報として備考を追加できます。 

Project information ダイアログの[Note]ボックスに備考を入力します。 

入力可能文字は英数半角で最大２８文字です。 
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ロット管理機能について 

デバイス書き込みの生産ライン作業現場において、作業個数または作業の進行状況を容易に確認するの

に便利なロット管理機能があります。また、作業完了報告のツールとして作業レポートファイルを出力できま

す。 

 

ロットサイズを設定する 

コントロールソフトをロット管理モードで動作させるには、メイン画面のプログレス コンディション グループ

ウィンドウに配置してある [Lot size] ボタンをクリックします。 

 

 

 

その後、Lot information ダイアログが表示されます。 

 

               
 

ロット管理モードのオプションには、ロット数/ロットナンバ／オペレータ／備考/オペレーションがあります。 

① 作業ロット数を入力する 

PASS 終了するデバイス数（作業ロットの目標値）が Lot information ダイアログの[Lot size]ボックスに入

力します。 

 

② ロットナンバを入力する 

ロットの識別・検証情報として任意のロットナンバを追加します。 

Lot information ダイアログの[Lot number]ボックスにロットナンバを入力します。 

入力可能文字は英数半角で最大２３文字です。 

ロットナンバは作業レポートおよび中間レポートのファイル名の一部に使用されます。 

 

③ オペレータ（作業者）を入力する 

もし必要であれば、ロットの識別・検証情報として任意のオペレータ情報を追加できます。 

Lot information ダイアログの[Operator]ボックスにオペレータ情報を入力します。 

入力可能文字は英数半角で最大２３文字です。 

 

④ 備考を入力する 

プロジェクトの識別・検証情報として備考に入力ができます。 

Lot information ダイアログの[Note]ボックスに備考を入力します。 

入力可能文字は英数半角で最大３５文字です。 

 

⑤ オペレーションを選択する  

ロット管理モードでは、作業するプログラマの動作モードを’Programmer mode’内から選択します。 

① Lot 数 

② Lot ナンバー 

③ 作業者名 

④ 備考欄 

⑤ オペレーション 

⑦中間レポート作成 

⑥ 作業開始・中断・終了 
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⑥ 作業開始・中断・終了について  

[1] 作業開始 

作業を開始するには、Lot information ダイアログの[Lot start]ボタンをクリックします。 

 

その後、「カウンタクリア」を問い合わせるメッセージが表示されますので、必要に応じて[はい]、[いいえ]ボ

タンをクリックします。 

Lot information ダイアログの表示は、[Lot end]および[Report]ボタンを除き、すべて選択できない状態にな

ります。 

設定した目標数は、メイン画面の[Lot size]ボタン右欄にも表示されます。 

  

※ 注意  

・ Lot Start 開始後、メニューオプション／ツールボタン 

は選択出来ない（選択禁止）状態になります。 

プログラマによる作業は、メイン画面のオペレーション 

パネルグループに配置されている[スタート]ボタン、また 

はプログラマ本体のスタートキーより行います。 

 

・オペレーションの作業が終了、又は「Lot end」を押し 

て終了しない限り、メニューオプション／ツールボタン  

は選択できません。 

（下記の「作業を中断する」を参照して下さい） 

 

 

一回の書込みが終了すると、カウンタの Pass、Total、Fail 各欄の数値が更新されます。 

PASS 数が目標（ロット数）に達するまで繰り返し、作業してください。カウンタはその都度更新されます。 

なお、実際の書込み PASS 数量をロット数に揃える機能はありません。実装したＲＯＭは全て書込みを行い

ます。繰り返し作業の最後の回が終了した時には、結果によって数量が一致または超過する場合がありま

す。 

 

プログラマは常時、PASS 数の監視を行います。 

PASS 数が、Lot information ダイアログに設定したロットサイズに到達する（一致または超える）と、画面に 

Lot end ダイアログが表示され、ロット数を達成した事をお知らせします。（ダイアログの表示は１回のみ） 

併せて、カウンタのパス欄の背景色が灰色からピンク色に変わります。 
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作業例） MODEL404 ／ロットサイズ 10 個／4 個同時書込み／２回目まで全数パスの条件にて 

   1 回目終了時 ： PASS 数 4 個 [4＜10]  達成通知なし 背景色（灰色） 

   2 回目終了時 ： PASS 数 8 個 [8＜10]  達成通知なし 背景色（灰色） 

   ――――――――――――――――――――――――――――――――――――――― 

   3 回目終了時 ： PASS 数 9 個 [9＜10]  達成通知なし 背景色（灰色） 

   ： PASS 数 10-12 個 [10-12≧10] 達成通知を表示 背景色（ピンク） 

   4 回目終了時 ： PASS 数 13-16 個 [13-16≧10] 達成通知なし 背景色（ピンク） 

 

 

Lot end ダイアログ上の、「はい（Y）」 ボタンを押すと、ここでロット管理モードでの作業を終了します。 

この時、作業レポートファイルが作成され結果が保存されます。（既にある場合は追記）。ロット管理モード

は解除され通常（非管理モード）に戻ります。 

「いいえ（N）」を押すと、“作業を継続する”事ができます。主に、目標数以上に生ＲＯＭを準備している状態

で、予定より多めに数量を確保したい場合、または書込みを全数行うような作業の場合にいいえを選択し

ます。作業レポートは作成・保存されません。 

継続した作業の終了、および作業レポートの保存については次項を参照ください。 

 

[2] 作業を中断する、または継続した作業を終了する 

ロット管理モードでの作業を中止するには、Lot information 

ダイアログの [Lot End] ボタン をクリックします。 

 

その後、再確認のメッセージが表示されますので、よろしけ  

れば [はい]、中止を取りやめる場合は[いいえ]をクリックしま 

す。ロット管理モードでの作業を中止した場合も作業レポート 

ファイルは作成されます。 

 

 

Lot information ダイアログ を閉じる 

Lot information ダイアログ を閉じるには、このダイアログ上のタイトルバーの閉じるアイコンをクリックし

ます。 

 

ロット管理モード作業中の場合、一旦ダイアログを閉じてから再度、メイン画面の[Lot size]ボタンをクリッ

クすると、Lot information ダイアログの一部は選択できない（選択禁止）状態になっています。[Lot End] 

で作業を中止することで解除されます。 

 

 

作業レポートファイルを出力する 

ロット管理モードでの作業が終了すると、自動的に作業レポートファイルが作成されます。 

作業レポートは、作業日／プログラマ毎に一つ作成されます。同一作業日に別の作業を行った場合はファ

イルの末尾にレポートが追加されます。 

 

保存先フォルダは、“C:\programmer\m404\support\log“ 

ファイル名は、“(ロットナンバ).log“  
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中間レポートファイルを出力する 

現在の作業の中間レポートファイルを出力するには、Lot information ダイアログの[Report]ボタンをクリック

します。 

（クリックする毎にファイルが作成されます） 

 

保存先フォルダは、“C:\programmer\m404\support\log“ 

ファイル名は、“(ロットナンバ)_repXXX.log“  （XXX は 000 から始まる連番） 
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作業の進行状況確認について 

作業の進行状況をカウンタまたはプログレスバーなどの表示から容易に確認できます。 

また、オペレーションの動作時間を確認できます。 

 

① カウンタ 

カウンタは、メイン画面のプログレス コンディション グループウィンドウに配置されています。カウンタは、

オペレーション結果のパス（良）、フェイル（不良）、トータル（合計）の３つの値を表示します。またオペレーシ

ョン毎に値を保持しており、デフォルトではこれらの値の合計が画面に表示されます。 

カウンタのタイプは、増加型です。 

 

プログレス コンディション グループウィンドウ 

 

 

 

 

 

カウンタに反映されるのは、コンタクトチェック及びデバイスＩＤチェックの結果が共にパスであるものがカウ

ントの対象です。 

全てのデバイスがコンタクトチェック又はデバイスＩＤチェックでフェイルであった場合、３つのカウンタは更新

されません。 

 

また、カウンタの機能として、指定したオペレーションのみカウントアップさせることができます。詳しくは下

記に示している「カウンタの設定をカスタマイズする」を参照してください。 

 

カウンタをクリアする 

カウンタをクリアするには、メイン画面のプログレス コンディション グループウィンドウに配置されている

[Clear Statistics]ボタンをクリックします。 

その後表示される確認メッセージでよければ、[はい]を、クリアを取り消す場合は[いいえ]をクリックします。 

 

特定のオペレーションに対するカウンタのみクリアする事もできます。 

詳しくは下記に示している「カウンタを個別にクリアする」を参照してください。 

 

 

 

カウンタの設定をカスタマイズする 

カウンタの設定をカスタマイズするには、[File] -> [Pass/Fail counter]メニューオプションを選択します。

Pass/Fail counter ダイアログが表示されます。 

  

 

① カウンタ 
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 Pass/Fail counter ダイアログ 

 

 

 

 

 

 

 

 

オペレーション名 

イネーブル <Enable>項のチェックボックスの右側にオペレーション名を表示しています。 

 

表示する合計値  

イネーブル <Enable>項のチェックボックスにチェックがされているオペレーションの値を合計した値が Total

カウント部分に表示され、同時にメイン画面上の PASS/FAIL/TOTAL にも表示されます。 

各カウンタに値が入っている時に、チェックボックスをチェック／非チェックに切り替えると、表示する合計値

が更新されます。 

 

 

          
 

例： ＢＬＡＮＫのチェックを外すと、右端の[Total]欄が全て０になります。 

再度チェックすると、９，３，１２が表示されます。 

 

 

7  カウンタを個別にクリアする 

オペレーション毎に保持しているカウンタ値は、個別   

にクリアできます。 

特定のオペレーションのカウンタをクリアするには、 

各[Clear]ボタンをクリックしてください。 

なお、確認用のメッセージは表示されません。 

 

8  [All clear] ボタンをクリックすると、全てのカウンタ

値をクリアします。 

同様に、確認用のメッセージは表示されません。 

 

Pass/Fail counter ダイアログを閉じる 

Pass/Fail counter ダイアログを閉じるには、[Cancel]ボタンをクリックするかタイトルバーの[閉じる]ボタン

をクリックします。 

この場合は、設定は変更されずにダイアログのみ閉じられます。 

イネーブル チェック ボックス 

チェックを外すと Total カウントから除外されます。 

 

① 
② 
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その他の画面情報   

① ロットサイズを指定した時の PASS カウント表示 

カウンタのパス（良）値がロットサイズを超えるとカウンタのパスボックスの色が“背景色”から“ピンク”に

変化して達成を通知します。 

その後、オペレーションを継続するとカウンタはカウントアップを続けますが、パスボックスの色は引き続

き“ピンク”となります。 

カウンタをクリアすると、ボックスの色が背景色に戻ります。   

 

 

 
 

② プログレスバー表示 

プログレスバーは、作業の進行状況を示します。 

プログレスバーは、メイン画面のプログレス コンディション グループウィンドウに配置されています。 

プログレスバーは、カウンタのパス（良）値及びロットサイズで構成されます。プログレスバーの表示は、

ロットサイズを１００％とした時のパス値の割合を示します。 

パス値がロットサイズ以上の場合は、計算上切り捨てられ１００％のままです。表示枠の右端に到達した

まま変化しません。カウンタをクリアすると、０％に戻ります。 

 

 

③ オペレーションの平均動作時間表示 

オペレーションの平均動作時間は、メイン画面のプログレス コンディション グループウィンドウの[AVG. 

Time] ボックスに表示されます。表示単位は秒（ｓ）です。 

オペレーションを切り替えると０秒にクリアされます。 

 

オペレーションの一回毎の動作時間表示 

オペレーションの一回毎の動作時間は、メイン画面のログウィンドウに“time: xx s”表示されます。表示単

位は秒（ｓ）です。 

 

 

コントロールソフトの操作およびオペレーションなどの内容が、メイン画面のログウィンドウに表示されま

す。また、ログファイルとして下記の場所 ( デフォルト ) に記録されます。  

保存先は、“C:\programmer\m404\support\log“又は、“D:\programmer\m404\support\log“  （デフォ

ルト） 

 

8  システムログのファイルフォルダを変更するには、[File] -> [Control of a log file] -> [Log file path]ボ

ックスを変更します。ファイルフォルダを指定した場合は、以降そのフォルダがデフォルトフォルダになり

ます。 

 

② システムログの保存期間を変更する 

システムログについて 

②プログレスバー 

③平均動作時間 

①ピンク色に変化 
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 システムログのファイル保存期間を変更するには、[File] -> [Control of a log file] -> [file retention 

period]ボックスの数値を変更します。左から[月数] ／ [日数] の順に並んでいます。 

例） １０日間に設定する場合、[月数]に“０”、[日数]に“１０”を入力します。 

 

ファイル名は、“multp(XXXXXX).log“  （XXXXX は年月日の６桁） 

ファイルの保存期間は、１４日間  （デフォルト値） 

 

ファイルフォルダおよび保存期間を変更できます。 ファイル名は変更できませんので注意して下さい。 

 

 

 

 

 

 

Control of a log file ダイアログの[OK]ボタンをクリックすると確定します。 
 

 

② 保存期間 
① ファイルフォルダ指定 
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オートスタート 

オートスタートは、デバイスをセットすると、ＳＴＡＲＴボタンを押さなくても自動的に作業を開始する機能で

す。ＳＴＡＲＴボタンを押さないままデバイスを回収してしまいブランク品が混入するというミスを防止できま

す。 

 
 

1. 通常の作業と同じようにアダプタを取り付け、デバイスを選択します。 

2. オペレーションモードを選択します。メニュー［Operation mode］の一覧から選択してください。 

 

 
 

 

3. オートスタートモードをＯＮにします。メニュー［Programmer］－［Auto Start］－［Mode］－［ON］を選択

してください。 

 

 

※注意 

アダプタの取り付け、取り外しは、デバイスを取り外した状態で行ってください。 

デバイスを取り付けたまま、アダプタの取り付け、取り外しを行うと、デバイスを破損する恐れが

あります。 

 

対応バージョン 

UniversalControlProgram ・・・V2.06 以降 

MODEL400、400e+シリーズファームウェア・・・V1.25 以降 
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4. アダプタが取り付けられているソケットは、ＬＥＤが赤色に点滅します。アダプタが取り付けられている

のに赤点滅にならない場合は、接触不良が考えられます。取り付け直してください。それでも、動作し

ない場合は、「Universal Control Program」とプログラマ本体のバージョンを確認してください。 

 
 

5. 応答時間を設定します。応答時間とは、「デバイスを載せてから安定するまでの時間」「デバイスの取り

外しが完了する時間」「アダプタの取り外しが完了する時間」です。メニュー［Programmer］－［Auto 

Start］－［Response time］から選択してください。 

 

 
 

6. アダプタにデバイスをセットします。セットすると、ＬＥＤが赤色から緑色の点滅になります。 

 
7. サイト毎に赤点滅が全て緑点滅になると、自動的にＳＴＡＲＴします。 

8. デバイスの数が少ない場合には、使用しないアダプタを取り外すか、画面上のＳＴＡＲＴボタンを押して

ください。 

 

9. 書き込みが完了すると、ＬＥＤが緑点灯（ＰＡＳＳ）か赤点灯（ＦＡＩＬ）になります。 

 

 

 

 

※オートスタートモードが「ＯＮ」の場合は、プログラマ本体のＳＴＡＲＴキーは使用出来ません。 

（点滅）  デバイスをセットしてください。 

（点滅）  デバイスがセットされています。 

デバイスをセットしても、赤点滅のままの場合は、接触不良の可能性があります。 

セットし直してください。 
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10. デバイスを取り外します。 

11. 次のデバイスで作業を行う場合は、6.に戻ってください。 

12. オートスタートモードを終了します。、メニュー［Programmer］－［Auto Start］－［Mode］－［OFF］を選

択してください。 

 

 

 

（点灯）  ＦＡＩＬ 

（点灯）  ＰＡＳＳ 
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プログラマ本体の設定について 

ブザーの設定 

プログラマ本体に搭載してあるブザーのＯＮ／ＯＦＦ設定を切り替えることができます。 

コントロールソフト終了時に、設定は保存されます。 

※ コントロールソフトの動作モードが DEMO モード又はオフラインの場合、ブザーはなりません。 

((ブザー音が発生するイベント)) 

 

ブザーをＯＮする 

ブザーをＯＮにするには、[Programmer] -> [Buzzer] -> [ON] メニュー

オプションを選択します。 

 

ブザーをＯＦＦする 

ブザーをＯＮにするには、[Programmer] -> [Buzzer] -> [OFF] メニュー

オプションを選択します。 

 

 

 

データファイルの履歴を削除する 

必要な場合、プログラマ本体のデータファイルの履歴(ＳＤ内部のデータ)を削除できます。履歴を削除する

には、[Programmer] -> [Clear SD]メニューオプションを選択します。 

その後、表示される確認メッセージでよければ、[はい]ボタンを、削除を取り消すには[いいえ]ボタンをクリッ

クします。 

 

履歴を削除した場合、次に作業を行う時に再度書き込みデータファイル

をプログラマに転送する必要があります。 
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 PC 内バッファの設定変更について 

PC 内バッファの場所を変更することが 

できます。 

( デフォルト; C ドライブ 又は D ドライブ ) 

 

 

C ドライブ 又は D ドライブに デバイス以上の空きスペースがない場合、外部ハードディスクに設定する

ことが可能です。 設定することで PC バッファが外部ハードディスクに作られます。 

（ できる限り、C ドライブ 又は D ドライブに空きスペースを設けて PC 内部ハードディスクの設定で行う

ことをお勧めします。） 

 

 ※ 注意事項  

① バッファとして外部ハードディスクを設定した場合、外部ハードディスクを外さないで下さい。 データの

破損に繋がります。 

② PC 内バッファを外部ハードディスクに設定していることを認識して、運用してください。 

 

スレーブモードについて 
  

データファイルをプログラマ本体のバッファメモリ(SD)

に直接データを送ることが可能です。 

 

例)  

大容量のデバイスを扱うときに、通常 PC 内バッファ

を介してプログラマバッファ(SD)にアクセスしますが、スレーブモードにすると、PC 内バッファを介さずに直

接にプログラマバッファ(SD)にアクセス出来ますが、出来る限り通常モードで作業することをお勧めしま

す。) 

※ 注意事項 

① PC 内バッファを介さないため、バッファエディタを閲覧及び加工することはできません。((エディタウ

ィンドウ画面)) 

② スレーブモードでは、デバイス COPY は出来ません。 (( COPY 動作 )) 

404  スレーブモードに設定していることを認識して、運用してください。 

 

PC内バッファの設定について 
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オペレーションについて 

オペレーションの進行状況を確認する  ((メイン画面の機能説明)) 

メイン画面のソケットステータスグループ、またはログウィンドウにてオペレーションの進行状況を確認でき

ます。 

 

① 単体オペレーション名表示 

現在、動作している単体オペレーションが、メイン画面のソケット 

ステータス グループ内のオペレーションボックスに表示されます。

待機状態（オペレーションが動作していない）では、[TEND]が表示

されます。 

 

 

② 単体オペレーションの進行状況 

現在、動作している単体オペレーションの進行状況が、メイン画面のソケット ステータス グループ内のプ

ログレスバーに（および％が）表示されます。待機状態（オペレーションが動作していない）では、前回の最

後の状態（１００％）が表示されています。 

 

 

オペレーション／ソケットステータスの動作／結果を確認する 

メイン画面のソケット ステータス グループ、及びログウィンドウにてオペレーションの動作と結果を確認で

きます。 

プログラマ本体のブザー音、ＬＥＤランプの点灯色でもオペレーションの終了と結果を確認できます。 

※DEMO モード及び オフラインの場合は、ブザー音はなりません。 

※プログラマが接続されている時のソケットの色は灰色, 未接続の場合、ソケットの色は白色になります。 

 

（例：ＭＯＤＥＬ 404、404e+） 

 

 

 

 

 

 

 

 

                       

                                

         未接続の場合（ソケット色は白色）               接続の場合（ソケット色は灰色） 

  

① ② 
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緑： オペレーションパス     

赤： オペレーションフェイル 

 

オペレーションパスは、緑色のソケットを表示します。 

オペレーションフェイルは、赤色のソケットを表示しま

す。 

 

 

 

ログウィンドウで結果を確認する 

メイン画面のログウィンドウでは、単体オペレーション名、サイト番号、対象サイトの終了時刻、オペレーショ

ンの動作時間を確認できます。 

 

その他の画面情報 

その他、オペレーションの開始を画面の変化より知ることができます。 

オペレーションが開始すると、メニューオプション／ツールボタンは選択できない（選択禁止）状態になりま

す。オペレーションが終了すると、再度選択可能な状態に戻ります。 

   

    
 

ブザー音で結果を確認する 

ブザー音と結果を以下に示します。 

単長音（─）  ：オペレーションパス（ソケット色で緑と灰のみ） 

断続音（・・・・） ：オペレーションフェイル（ソケット色で赤を含む） 

※DEMO モード及び オフラインの場合は、ブザー音はなりません 

 

 

その他の画面情報 

オペレーションを中断する 

オペレーション開始後、途中でオペレーションを停止させる場合は、オペレーション パネル グループ 

ウィンドウのストップボタン  をクリックします。 

動作中のソケット表示 

動作結果のソケット表示 

  

オペレーション動作中は、赤線のサイト表示が点滅を繰り返します。（オレンジ色） 

オペレーション終了後、サイト表示は薄緑色に戻ります。 

 

PASS FAIL 
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オペレーションを中断した時の結果表示を以下に示します。 

 

ソケットの色：全て赤 

ブザーの音 ：断続音（・・・・） 

ＬＥＤ点灯色：全て赤 

カウンタ値 ：値は変わりません 

 

※ オペレーションの途中で中断することは、なるべく避けて下さい。 デバイスの破損に繋がります。 

確認の上、行って下さい。 
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オペレーションのカスタマイズ設定  

 

デバイスチェックの有無、デバイス書き込み時の動作指定を行うことが出来ます。 

オペレーションのカスタマイズを設定するには、Device->Device operation options メニューオプションを選択

します。 

 

[ Device Address ] 

Device start Address (Word/hex) (固定値) 

選択したデバイスのスタートアドレス 

 

Device end Address   (Word/hex) (固定値) 

選択したデバイスのエンドアドレス 

 

Buffer start Address  (byte/hex)  (固定値) 

バッファメモリのスタートアドレス 

 

[ Insertion test ]  ※チェックを付けた状態が [ 有効 ] です。 

Contact check 

コンタクトチェックの [ 有効 / 無効  ]   

※デフォルトは [有効 ] 

 

ID check 

ID チェックの [ 有効/無効 ]  

※デフォルトは [有効 ]       

                  オプション設定画面 

 

 

 

Contact check STOP set 

コンタクトチェックで Fail として判定した時に、その時点で STOP [有効/無効] する。 

※無効(チェックを外した状態)にした場合、STOP せずに次の動作に移ります。 

 

ID check STOP set 

ID チェックで Fail として判定した時に、その時点で STOP [有効/無効] する。 

※無効(チェックを外した状態)にした場合、STOP せずに次の動作に移ります。 

 

[ Command execution ] ※ チェックが付いた状態 [有効] です。  

BLANK before PROGRAM 

PROGRAM の前に BLANK を行います。[ 有効/無効 ]   

※デフォルトは [有効] 

 

ERASE before PROGRAM 

PROGRAM の前に ERASE を行います。[ 有効/無効 ]   

※デフォルトは [ 有効 ] 

 

 

BLANK after ERASE 

ERASE の後に BLANK を行います。[ 有効/無効 ]   

※デフォルトは [ 有効 ] 

 

画像は一例です。デバイスにより 

一部変更することがあります。 
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VERIFY after PROGRAM 

PROGRAM の後に VERIFY を行います。[ 有効/無効 ]   

※デフォルトは [有効] 

 

 

VERIFY after COPY 

COPY の後に VERIFY を行います。[ 有効/無効 ]   

※デフォルトは [有効] 

 

 

VERIFY  COUNT 

Default・・・・・・・・・・・ VERIFY を ２ 回 行います。 ※デバイスによって異なります。 

Once・・・・・・・・・・・・・ VERIFY を 1 回行います。  

 

 

[ Programming parameters ] 

設定しているデバイスのタイプ 

 

 

[ Erase parameters ] 

Erase を行う範囲の指定 
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システム関連について 
言語 

コントロールソフトでは、メッセージダイアログの表示言語を日本語または英語に切り替えることができま

す。 

[Help] -> [Choice of the language]メニューオプションから言語を選択してください。 

※ デフォルトの表示言語は英語です。 
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クイックスタート 

 

ソフトウェアと USB ドライバのインストール 

付属の CD-ROM を PC にセットします。 

インストール手順は、インストールをするを参照して下さい。 

 

 

 

プログラマ・ハードウェアのインストール 

     MODEL400 シリーズプログラマ本体の USB ポートと PC の USB ポートを付属の USB ケーブル 

     で接続します。 

    ※ USB ケーブルはソフトウェアのインストール終了後に接続してください。 

 

 

コントロールソフトの起動 

     デスクトップ画面上の    をダブルクリックしてください。 

     コントロールソフトはパソコンに接続されているプログラマを検出します。 

 

 

言語表示を変更する。 

 TOP メニューの Help －＞ Choice of the language  -＞ 言語選択 (English or Japanese)  
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デバイス書き込み方法 
   

404  使用するデバイス選択を選択します。 ----- ＞       をクリック         

    

7  書き込むデータをバッファに読み込む。  

 

       A )   ファイルからロードする場合  -----＞ をクリック 

            

       ｂ）   デバイスからリードする場合  -----＞ ZIF ソケットにデバイスを装着し、 

 

             をクリック  

 

 

8  書き込みたいデバイスを DIP ソケットに装着  

 

   ④連続動作でデータを書き込む。  -----＞ をクリック 

a) 未書き込み状態がチェック（ＢＬＡＮＫ）されます。 

b) データが書かれているデバイスはデータ消去（ＥＲＡＳＥ）を実行します。 

c) デバイスにデータを書き込み（ＰＲＯＧ）ます。 

d) 書き込んだデータとバッファのデータが照合（ＶＥＲＩＦＹ）されます。 

 

コントロールソフトの詳しい説明を 「メイン画面の機能説明」にて記載しています。 
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トラブルシューティング 

 

Q.1 

プログラマが PC に認識されない。 USB 接続がうまく接続されない。 

 

A.1 

確認作業 

  ① MODEL400installer( アプリケーションソフト ),USB_driver ( USB ドライバー )は、正しくインストール

されていますか？ 

  ② USB ケーブルは正しく接続していますか？ プログラマの電源は、入っていますか？ 

  ③ プログラマが PC に認識されているか確認します。 

  ④ 接続している PC に、はじめてプログラマ本体を接続しましたか？  

      (( はじめて接続する PC 上でのお願い )) 
 

     WINDOWS XP の場合 )  

   [スタート]→[ コントロール パネル ]→[システム]→[ハードウェア]→[ デバイス マネージャ ]→[ ポ

ート ] 

   で接続の確認ができます。 以下の表示が出ていれば接続可能です。  

 

 

           

 

 

                                                                                                       

例 ) MODEL 404  

※ 表示は一例です。 接続ポートはそれぞれ異なります。 

   

    PC 上の USB ポート（ポートが 2 個以上ある場合）を変更し、プログラマを再立ち上げして下さい。それ

でも、認識されないときは、弊社までご連絡ください。 
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メッセージについて 

 
  

番号 メッセージなど 誘導  ／エラー／注

意 ／処理中 

説明 

001 

 

C:\ディスクに空き容量がありま

せん。 

空き容量 ： ***MB 

要求する空き容量： 

          ***MB 

注意／誘導 C ディスクに空き容量がありません。 

空き容量を増やしてください。 

 

002 

 

Site #* のプログラマとの通

信エラーが発生しました。 

エラー 通信エラーです。 

アプリケーションから閉じ、プログラマの電源を落

として下さい。今度は、プログラマを先に再起動

し、その後、アプリケーションを立ち上げて下さい。 

003 

 

 

プログラマとの通信エラーが

発生しました。 

エラー 通信エラーです。 

アプリケーションから閉じ、プログラマの電源を落

として下さい。今度は、プログラマを先に再起動

し、その後、アプリケーションを立ち上げて下さい。 

004 

 

アプリケーションとプログラマ

間で通信エラーが発生しまし

た。 

エラー 通信エラーです。 

アプリケーションから閉じ、プログラマの電源を落

として下さい。今度は、プログラマを先に再起動

し、その後、アプリケーションを立ち上げて下さい。 

005 

 

ファイルの転送に失敗しまし

た[ファイル名]。 

エラー ファイルの転送を失敗しています。 

ファイルを再転送して下さい。 

006 

 

 

SD からのファイルの読み出

しに失敗しました。 

エラー プログラマ内の SD メモリの読み出しにエラ

ーを起こしました。再度、読み出しを行って

下さい。 

007 

 

 

SRAM メモリチェックでエラー

発生しました。 

エラー プログラマのメモリーにエラーを起こしまし

た。アプリケーションから閉じ、プログラマの

電源を落として下さい。今度は、プログラマ

を先に再起動し、その後、アプリケーションを

立ち上げて下さい。 

008 

 

CRC 計算値の読み出しに失

敗しました。 

 

エラー プログラマ側の CRC 計算値の読み出しエラ

ーです。再度、読み出しを行って下さい。 

009 

 

SD ファイルの削除に失敗し

ました。 

エラー プログラマ内の SD メモリ上のファイル削除

にエラーを起こしました。再度、削除を行って

下さい。 

010 

 

不正なコマンドを受信しまし

た。 

エラー 動作コマンドの通信エラーです。 

再度、動作コマンドを選択してください。 

011 

 

アプリケーションとプログラマ

間で通信エラーが発生しまし

た。プログラマをリセットして

下さい。 

エラー 通信エラーです。 

アプリケーションから閉じ、プログラマの電源

を落として下さい。今度は、プログラマを先に

再起動し、その後、アプリケーションを立ち

上げて下さい。 
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番号 メッセージなど 誘導  ／エラー／注

意 ／処理中 

説明 

012 

 

オプションデータの読み出しに

失敗しました。 

エラー オプション設定データの読み出しエラーです。 

再度、オプション設定し転送して下さい。 

013 

 

コンタクトチェックで Fail Socket 

があります。 

表示； 

ソケット: 赤色 

エラー コンタクトチェックエラーです。 

デバイスをチェックして下さい。 

 

続行の時は、エラーが出たソケットのデバイス

を外して下さい。 

 

014 

 

ID チェックで Fail Socket があり

ます。 

 

  表示 ；  

 

エラー ID チェックエラーです。 

デバイスをチェックして下さい。 

 

続行の時は、エラーが出たソケットのデバイス

を外して下さい。 

 

015 

 

 エラー LED 表示のエラー 

アプリケーション及びプログラマを再起動して下

さい。 

016 

 

ログファイル格納パスの指定は

無効です。 

エラー 通信ログ関係の格納場所を変更した場所に出

る可能性がある 

017 

 

ロットサイズが不正です。 注意 ロットサイズの誤り入力です。 

訂正して下さい。 

018 

 

 

通信エラーが発生しま した。

BINDATA を再転送しますか？ 

処理中 

 

 

通信を中断された時のエラーです。 

メッセージに従ってください。 

 

019 

 

オーバカレントエラー 

( メッセージなし) 

 

  表示 ；  

 

エラー オーバカレントエラーです。 

エラーソケットからデバイスを外して 

デバイスをチェックして下さい。 

そのまま、測定することは避けて下さい。 
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バージョン情報の確認 

コントロールソフトのバージョンは TOP メニュー上の Help  ―＞ About Universal Control Program 

Version で確認することができます。 

 

バージョンアップ 

ソフトウェアのアップデートは常時行っています。 

新しいデバイスが開発された時、デバイスの書き込みに変更があった場合には、随時、アルゴリズムの      

更新及び追加を行っています。 

MODEL400 シリーズ用コントロールソフトをアップデートすることによりアップデート時点の最新アルゴリズム

に更新することが出来ます。 

 

MODEL400 シリーズ用コントロールソフト（Universal Control Program） の最新版へのアップデートは、販売

店または、弊社までご連絡下さい。  
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起動時の接続モード 

 
 

起動時に Use Handler を選択した場合、プログラマはオフラインモードで立ち上がります。 

その後ハンドラ側からの接続要求コマンドを受け取ると、オンラインモードになります。 
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ブザー音が発生するイベント 

ブザー音が発生するイベント 備考 

プログラマ本体の電源オン 設定に関わらずブザーが鳴ります 

UniversalControlProgram の起動完了  

デバイスの変更完了  

動作オプションの変更完了  

オペレーションの実行終了 音の種類は動作結果により異なります 

  

  

 

プロジェクトファイルに保存される設定 

カテゴリ 項目 項目の補足 保 存 の

有無 

備考 

 プロジェクトＩＤ プロジェクトの識別情報 ○ 保存時に入力 

 プロジェクトの備考 プロジェクトの識別情報 ○ 保存時に入力 

デバイス デバイス型番  ○  

 パッケージ  ○  

 変換アダプタ型番  ○  

データ ファイル ファイルパス・ファイル名 ○  

 データ バイナリデータ ×  

 ファイルフォーマット  ○  

 演算範囲 スタート・エンドアドレス ×  

 バイトＳＵＭ  ○  

 ワードＳＵＭ（リトル） リトルエンディアン ×  

 ワードＳＵＭ（ビッグ） ビッグエンディアン ×  

 ＣＲＣ３２  ○  

 ＣＲＣ１６  ×  

 ＣＲＣ－ＣＣＩＴＴ  ×  

 ＳＷＡＰオプション  ×  

 クリアオプションデータ  ×  

 オフセットオプション  ×  

 オフセットアドレス  ×  

オ ペ レ ー

ション 

オペレーション 選択オペレーション ○  

 オプション アドレス範囲・複合指定 ○  

カウンタ カウンタ値 パス、フェイル、トータル ×  

 カウンタ設定 カウンタイネーブル ×  

タイム 平均動作時間  × （ＢＬＡＮＫに切り替わ

り）クリア 

 動作時間 オペレーション１回 ×  

ロット ロットサイズ  ×  

システム データファイルフォルダ ブラウズ時の表示フォルダ ×  

 ログファイルフォルダ ブラウズ時の表示フォルダ ×  

 ログ保存期間    

 ブザー ＯＮ／ＯＦＦ設定 ×  

 ツールバー 表示／非表示設定 ×  
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 ステータスバー 表示／非表示設定 ×  

 言語 ツールヒント表示言語 ×  

 

 

作業レポートファイルに保存される項目 

カテゴリ 項目 項目の補足 保存の

有無 

備考 

ヘッダ バージョン UniversalControlProgrammer ○  

 モデル 404、404e+／408、408e+／

416、416e+ 

○  

 プログラマ本体番号  ×  

 ロット番号 ロット識別情報 ○ 作業開始時に入力 

 オペレータ ロット識別情報 ○ 作業開始時に入力 

 備考 ロット識別情報 ○ 作業開始時に入力 

 デバイス メーカ名・デバイス型番 ○  

 パッケージ  ○  

 変換アダプタ型番  ○  

 プロジェクト ファイル名 ○  

 書き込みデータ ファイル名 ○  

 バイトＳＵＭ  ○  

 ＣＲＣ３２  ○  

 作業開始時間  ○  

 作業終了時間  ○  

オ ペ レ ー

ション 

オペレーション 選択したオペレーション（動

作モード） 

○  

 オプション アドレス範囲・複合指定 ○  

カウンタ カウンタ設定 カウンタイネーブル ×  

タイム 平均動作時間  ×  

結果 ロットサイズ  〇  

 パス数  ○  

 フェイル数  ○  

 パスフェイル合計  ○  

 トータルパス率 パス÷パスフェイル合計 ○ ÷ロットサイズではな

い 

 

 

メインメニュー 

メニュー メニューオプション ツールバー 機能説明 

File Load project… 
 

プロジェクトファイルの読み込み 

 Save project… 
 

プロジェクトファイルの保存 

 Load file to buffer 
 

データファイルの読み込み 

 Save buffer to file 
 

データファイルの保存 

 Config  システムの変更（設計者のみ） 

 Control of a log file  ログファイルの管理 

 Pass/Fail counter  カウンタの設定 
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 Verify check sum  個々のベリファイサムと期待値の比較 

 Deletion of the data file  作業用データファイルの削除 

 Open log file  ログファイルを開く 

 (Recent file)  最近使用したプロジェクトファイル 

 Exit  アプリケーションの終了 

Edit Edit buffer 
 

バッファエディタ 

Programmer Buzzer  ブザーの設定（本体） 

 Self test  プログラマの検査 

 Clear data  本体バッファデータの全消去 

 File list  本体バッファデータ内のファイル一覧 

 LED Check  LED 検査 

 Handler position  ハンドラ使用時のみ：プログラマの番号の設定 

Device Select device… 
 

デバイス選択 

 Operation options… 
 

オペレーションのカスタマイズ 

 Writing of unique ID  ハンドラ使用時のみ：ユニークＩＤの書き込み 

 Access method 
 

アクセス方法 

 Copy 
 

ＣＯＰＹオペレーション 

 Blank check 
 

ＢＬＡＮＫオペレーション 

 Verify 
 

ＶＥＲＩＦＹオペレーション 

 Program 
 

ＰＲＯＧオペレーション 

 Erase 
 

ＥＲＡＳＥオペレーション 

 Cont 
 

ＣＯＮＴオペレーション 

View Toolbar  ツールバーの表示／非表示 

 Status Bar  ステータスバーの表示／非表示 

 Function progress bar  Special：エラー発生時の進捗状況を表示 

 Contact check NG mark  Contact エラーの場合の、エラーマークの表示

／非表示 

 Handler NG code  ハンドラ使用時のみ：通常ＯＦＦ 

 SUM  SUM の表示方法 

Help About Universal… 
 

バージョンの表示 

 V_up  レビジョンアップ（本体） 

 Choice of the lang…  ツールヒント言語切り替え 

 

メインメニュー（バッファエディタ） 

 

メニュー メニューオプ

ション 

ツールバ

ーボタン 

機能説明 

Function Erase buffer 
 

バッファの初期化 

 Fill random 

data 
 

ランダムデータで初期化 

 Fill block 
 

指定データ列で初期化 

 Copy block 
 

部分コピー 

 Move block 
 

部分移動 



 

119 

M400-020A-K8 

 

 

 Swap data in 

block 
 

スワップ（並べ替え） 

 Find text 
 

データの検索 

 Replace text 
 

データの置換 

 Go to 

Address 
 

指定アドレスへジャンプ 

 Edit buffer 
 

編集モードに切り替え 

 View buffer 
 

閲覧モードに切り替え 

 Check SUM 
 

ＳＵＭ／ＣＲＣの確認 

 Exit  エディタの終了 

View Toolbar  ツールバーの表示／非表示 

 Status Bar  ステータスバーの表示／非表示 

 Byte  バイト単位で表示 

 Word  ワード単位で表示 

Help About 

BufferEditor 
 

バージョンの表示 

 Choice of the 

lang… 

 ツールヒント言語切り替え 
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用語集 

エンディアン （Endian） 

データ幅が９ｂｉｔ以上のデバイスを扱う場合に重要なキーワードで、バッファデータ（バイト単位＝８ｂｉｔで並

ぶデータ）をどのような組合せでデバイスに読み書きするかを表すのに使われます。 

詳しくは、後述のリトルエンディアン、ビッグエンディアンを参照してください。 

 

※ コントロールソフトでは、表示やデバイスへの読み書きなど、全てにおいてリトルエンディアンを基準に

しています。 

 

 

リトルエンディアン <Little endian> 

１６ｂｉｔデバイスを「バイト」というキーワードで表現する時、読み書きに必要な２つのバイトを、「上位バイト

（ビット１５－８）」「下位バイト（ビット７－０）」で示すことができます。 

バッファデータで最初に使うバイトを下位バイトに、その次を上位バイトという順序にする方式をリトルエン

ディアン（方式）と呼びます。この逆がビッグエンディアンです。 

 

※ コントロールソフトでは、表示やデバイスへの読み書きなど全てにおいて、リトルエンディアンを基準に

しています。 

 

 

ビッグエンディアン <Big endian> 

１６ｂｉｔデバイスを「バイト」というキーワードで表現する時、読み書きに必要な２つのバイトを、「上位バイト

（ビット１５－８）」「下位バイト（ビット７－０）」で示すことができます。 

バッファデータで最初に使うバイトを上位バイトに、その次を下位バイトという順序にする方式をビッグエン

ディアン（方式）と呼びます。この逆がリトルエンディアンです。 

 

 

サム （SUM） 

バッファデータをすべて加算した値をサム（英語の Summation の略）といいます。設定したデータが間違っ

ていないかなどの識別に使用します。 

 

以降にコントロールソフトで提供するサムについて説明しています。 

※ バッファエディタの「チェックＳＵＭ」で表示されます。 

 

バイトサム <Byte sum> 

バイト（８ｂｉｔ）単位で加算して得られる値です。 

 

※ バッファエディタの「チェックＳＵＭ」表示は、単純加算値です。 

 

 

ワードサム (リトルエンディアン)  <Word sum (Little endian)> 

ワード（２バイト）単位で加算して得られる値です。 

 

※バッファデータの並びをリトルエンディアンとして扱う場合のＳＵＭです。 

例：バッファデータが 01,02,03,04（hex）の場合、0201+0403=0604（hex）と加算します。 
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ワードサム (ビッグエンディアン)  <Word sum (Big endian)> 

ワード（２バイト）単位で加算して得られる値です。 

 

※バッファデータの並びをビッグエンディアンとして扱う場合のＳＵＭです。 

例：バッファデータが 01,02,03,04（hex）の場合、0102+0304=0406（hex）と加算します。 

 

バッファエディタの「チェックＳＵＭ」表示は、単純加算値です。 

 

XOR (排他的論理和) 

論理演算の一つです。 

バッファデータをこの演算を行った値を、サムと同様に設定したデータが間違っていないかなどの識別に使

用します。 

 

 

CRC <CRC>  ( Cyclic Redundancy Check, CRC ) 

「巡回冗長検査」の略。連続して出現する誤り(バースト誤り)の検出が可能な誤り検出方式。 

ＳＵＭと同じく、設定したデータが間違っていないかなどの識別に使用する値です。 

ＣＲＣはデータの並びが違うと異なる結果となりますが、ＳＵＭはデータの並びが違っても同じ結果（１＋２と

２＋１が同じように）になるときがあります。 SUM チェック及び CRC チェックを用いることでデータの信頼性

を高めることができます。 

 

以降にコントロールソフトで提供するＣＲＣについて説明しています。 

※バッファエディタの「チェックＳＵＭ」で表示されます。 

 

 

 

 

ＣＲＣ１６ <CRC16> 

生成多項式  ：X16+X15+X2+1 

結果のバイト数：２バイト 

 

ＣＲＣ－ＣＣＩＴＴ <CRC-CCITT> 

生成多項式  ：X16+X12+X5+1 

結果のバイト数：２バイト 

 

ＣＲＣ３２ <CRC32> 

生成多項式  ：X32+X26+X23+X22+X16+X12+x11+X10+X8+X7+X5+X4+X2+X+1 

結果のバイト数：４バイト 

 

 

ファイルフォーマット ( File format ) 

モトローラ (MOT), インテル(HEX), NO フォーマット(BIN) 

 

モトローラ (*.MOT) <Motorola (*.MOT)> 

レコードタイプ、アドレス、ＳＵＭなどの情報を持つ ASCII データ構成です。 

コントロールソフトでは、Ｓ４，Ｓ５，Ｓ６フォーマットは未対応（フォーマットエラー）です。 
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インテルＨＥＸ (*.HEX) <Intel HEX (*.HEX)> 

レコードタイプ、アドレス、ＳＵＭなどの情報を持つ ASCII データ構成です。 

 

ＮO フォーマット (*.BIN) <NO Format (*.BIN)> 

アドレス、ＳＵＭなどの情報を持たないバイナリデータのみの構成です。 

 

 

スワップ (Swap) 

バッファメモリデータの加工処理のひとつで、今あるデータの並べ替えを行う処理をスワップと呼びます。コ

ントロールソフトでは、エンディアンの変換用と（シリアルデバイスなどに関連する）最上位ビット－最下位ビ

ット間の順序逆転の機能を提供します。 

 

 

バッファオフセット （Buffer offset） 

アドレスの差を意味します。 

デバイスのみを捉えた時、そのアドレス空間は０から始まります。それに対し、マイコンの開発ツールなどで

生成されたデータファイルのアドレスが０から始まっていない場合があります。 

このような双方のアドレスの違いを吸収するためにバッファオフセットがあります。 

また逆に（アドレスを持たない：０に相当する）バイナリデータから、デバイスアドレスを指定するのにもバッ

ファオフセットが使用されます。 

 

 

ワンタイム <ＯＴＰ> 

デバイスの仕様で、“One Time Programable”一度のみ書き込みできるデバイスまたはデバイス内の領域を

示す場合に使用します。 

コントロールソフトでは、上記の機能に関連するものを説明する場合に用語を使用します。 

 

 

プロテクト <Protect> 

デバイスの機能の一つで、デバイスのデータが電気的なノイズなどの原因により（誤作動）書き替わってし

まわないようにするための保護機能です。 

コントロールソフトでは、上記の機能に関連するものを説明する場合に用語を使用します。 

これに似た用語でリードプロテクト（読み出し保護）がありますが、コントロールソフトでは、セキュリティのカ

テゴリと捉えています。 

 

 

セキュリティ <Security> 

デバイスの機能の一つで、外部からの意図的な書き替え、読み出しを防ぐための保護機能です。 

コントロールソフトでは、上記の機能に関連するものを説明する場合に用語を使用します。 

 

 

コンフィグレーション <Configuration> 

デバイスの機能の一つで、デバイス自身の動作を外部から電気的な「設定」により切り替えることができる

機能です。設定を変更するとデバイスの動作速度が変わる、読み出し方法が変わるなどの動作上の変化

があります。 

この「設定」は、揮発性（電源オフにより消える）／不揮発性／（更に）ＯＴＰの３種類に分かれます。 
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コントロールソフトでは、上記の機能に関連するものを説明する場合に用語を使用します。 

 

パーティション 

ハードディスク関連で使用される用語（パーティション）と同義語。主にＮＡＮＤデバイスを扱う時に使用しま

す。書き込みデータ及びデバイスのアドレス空間をいくつか分割し、それぞれの区画を結び付けることを意

味します。 

 

 

バッドブロック <Bad block> 

ＮＡＮＤデバイスの特有の仕様で、物理的な不良があり、機能上の問題がある管理単位（ブロック）を示す

場合に使用します。ＮＡＮＤデバイスの仕様では、デバイスの工場出荷時から、使用期間に至るまで、デバ

イス内に限られた数までのバッドブロックの存在が許可されています。 

 

 

ＥＣＣ（エラーチェック＆訂正） <ECC> 

データのエラーチェック及びエラー修正を行うためのデータです。ＮＡＮＤデバイスを扱う場合に、書き込み

データとは別に、デバイス内に書き込まれる事があります。ＥＣＣは、バッドブロック回避の仕組みの一部又

は、誤動作で変化したデータを訂正する目的で使用されます。 

 

サイト <Site> 

MODEL400 シリーズコントロールソフトの仕様の一つで、４ソケット毎に動作管理を分けています。それぞれ

をサイトと呼びます。 

 

ロット <Lot>／ロットサイズ 

生産単位または製造単位など様々な分野で単位を表す用語です。 
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お問い合わせ先一覧 

ミナト・アドバンスト・テクノロジーズ株式会社 

Minato Advanced Technologies Inc. 

 

 

・本社 

〒224-0026 

神奈川県横浜市都筑区南山田町 4105 番地 

TEL: 045-591-5611 / FAX: 045-591-6451 

E-mail: et-sales@minato.co.jp 

 

 

・大阪営業所 

〒553-0003 大阪府大阪市福島区福島 5-16-15 福島宮脇ビル 2 階 

TEL: 06-6453-8911 / FAX: 06-6453-8912 

 

 

・〒815-0031 福岡県福岡市南区清水 4-22-16 PS ビル 2 階 

TEL: 092-553-2540 / FAX: 092-553-2541 
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改版履歴 

 

版 作成日 内容 

１版 2010/06/25  － 

2 版 2010/11/01  追加及び修正 

3 版 2011/03/31  取扱説明書の名称変更及び内部追加修正 

4 版 2013/10/08 追加及び修正 

5 版 2014/11/10 USB ドライバのインストール手順の変更 

6 版 2015/07/01 会社名変更 

7 版 2015/11/18 ロット管理機能の説明文改訂および作業例追加。 

7.1 版 2017/06/29 事業所名変更。 「本社営業部」から「横浜事業所」へ 

7.2 版 2017/07/11 プロテクトについて追加 

8 版 2017/09/28 追加及び修正 

8.1 版 2018/05/07 会社名変更。事業所名ページ変更。 

8.2 版 2018/07/31 4 頁. 項”ロット管理機能について” の頁番号を訂正 

8.3 版 2018/10/01 会社名変更。ミナト・アドバンスト・テクノロジーズ株式会社へ 

8.4 版 2020/03/01 対応ＯＳ追加 

8.5 版 2022/05/10 営業所住所変更 

 

 


